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INTRODUCTION 

Thank you for purchasing Mitsubishi Electric Industrial Robot MELFA. 
This document is the operation manual for the MELSOFT "RT ToolBox  Robot Total Engineering Support 
Software". 
By fully utilizing the features of this software, you can perform the initial startup of the robot, and create, edit and 
control the robot programs. 
To operate the robot in a safe manner, be sure to read this manual and safety manual of attachment to the robot 
arm thoroughly in advance. Also, keep this manual in a location that provides an easy access whenever you need 
to refer to it. 
 
Target Version of This Manual 
This manual is for the "RT ToolBox  Robot Total Engineering Support Software" of version F2 or later.  
"RT ToolBox  Robot Total Engineering Support Software" version F2 edition corresponds to the version K4 of a 
robot controller.  
 
Target Readers of This Manual 
This manual is written on the assumption that the readers have sufficient knowledge of the basic operation of the 
personal computers, Windows 98/Me/NT 4.0/2000/XP as well as the robot controllers. 
If you are unfamiliar with the basic operation of the personal computers, please read the user’s manual of your 
personal computer. 
 
Symbols Used in This Manual 

CAUTION 
 

Indicates that incorrect handling may cause hazardous conditions, resulting
in injury of the operator, or only physical damage. 

WARNING 
 

Indicates a possibility that incorrect handling may cause hazardous 
conditions, resulting in death or severe injury of the operator. 

DANGER 
 

Indicates that incorrect handling is most likely to cause hazardous
conditions, resulting in death or severe injury of the operator. 

 
 

Please read this operation manual thoroughly and be sure to learn the correct operating procedures. 
 

 ● No part of this manual may be reproduced by any means or in any form, without prior consent from
Mitsubishi. 

● The details of this manual are subject to change without notice. 
● An effort has been made to make full descriptions in this manual. However, if any discrepancies or

unclear points are found, please contact Mitsubishi. 
 

Microsoft, Windows, Microsoft Windows NT are either registered trademarks or trademarks of Microsoft Corporation
in the United States and/or other countries. 
Acrobat Reader Copyright 1987-1999 Adobe Systems Incorporated. All rights reserved. 
Adobe, the Adobe logo, Acrobat, and the Acrobat logo are trademarks of Adobe Systems Incorporated. 
Reference to registered trademarks and trademarks are omitted in this manual. 

 
Copyright(C)1999-2006 MITSUBISHI ELECTRIC CORPORATION 

 
 
 

 
 
 
 





 

 

How to Ensure Stable Communication Between the "RT ToolBox  Robot Total 
Engineering Support Software"  and the Robot Controller 

When communicating with the robot controller (hereinafter referred to as the R/C) using the "RT ToolBox  Robot 
Total Engineering Support Software"  (hereinafter referred to as the Software), depending on the personal 
computer model and settings the communication may become unstable in a batch backup or program 
upload/download where large amounts of data are transmitted. To ensure stable communication with the R/C, 
change the communication settings (communication protocol) of the R/C and the Software as shown below. If the 
communication settings of the R/C and the Software do not match, normal communication cannot be established. 
Be sure to change the settings on both the R/C and Software sides. 
 
(1) The Robot Controller 

As for the R/C communication settings, change the following parameters: 
Parameter Default Change to 

communication protocol (CPRC232) 0 (Non-Procedural) 1 (Procedural) 
* To communicate with the personal computer via an extended RS-232C port by using an extension serial 

interface board, change the parameters of the extended RC-232C port. 
 

(2) "RT ToolBox  Robot Total Engineering Support Software" 
Change the communication settings of this Software through the "communication server." 

Parameter Default Change to 
Protocol Non-Procedural Procedural 

 
 

Change to Procedural

 
z When communicating with the R/C using your custom software, reset the R/C protocol setting to 

"Non-Procedural" in advance 
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1. Before starting use  
 
The manual is in the CR-ROM as the Adobe PDF file. 

D：/Doc/BFP-A8090.pdf 
* Example for the CD-ROM drive is “D:”. 

 
For reading the manual, Adobe Acrobat Reader Ver.5.0 or more is required. 

If Adobe Acrobat Reader isn’t installed, please download from following Adobe Systems Incorporated 
URL(As of December, 2004). 

URL:  http://www.adobe.com/ 
 
This chapter explains the precautions to be observed when using this software. 
 

1.1. Using the instruction manual 

The contents of this instruction manual are briefly explained in this section. Refer to the required section as 
necessary. 

 

1. Before starting use   
The precautions before starting use are explained. Please read before starting use. 

 
2. Preparation before use   

The methods of starting up this software are explained. 
 
3. Basic function and windows operations   

The functions of this software, and the basic windows operations required for using this software are 
explained. 

 
4. Starting use   

This is a tutorial section for learning the series of operation methods when using this software for the 
first time.  
 

5. Program editing tool   
A detailed explanation of making and saving the robot program.  

 
6. Monitoring   

All of the information in the currently connected robot controller can be constantly displayed.  
 

7. Parameter editing tool   
The parameters in a Robot controller can be referred to and rewritten.  

 
8. Backup/restore   

A backup of the data in the robot controller can be downloaded to the personal computer, and the 
backup data saved in the personal computer can be uploaded to the robot controller.  
 

9. Remote maintenance   
The data of a robot at a remote location can be monitored and serviced over a telephone line.  

 
10. Simulation   

Confirmation of robot program operation with off-line simulation using CG [Computer Graphics], and 
calculation of cycle time 

The Simulation function becomes correspondence only of a standard version(STD).  
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11. Program conversion   

The program conversion converts the position data as well as the instructions (DJ, MP, and PD 
instructions of the Move Master command) related to the position data so that the robot programs created 
and saved by the "Robot Programming Supporter" can be used with this new S/W.  
 

12. Position repair  
In case a deformation of a tool occurs due to interference or a deviation from origin point (OP) 
occurs due to the replacement of the motor during maintenance, the previous position data 
retained in the controller can be used by performing a teaching operation again for part of the 
position data. 
 

13. Maintenance report  
The parts replacement (grease replenishment, battery and belt replacements) periods can be 
referenced from the up-to-date operating data collected inside the controller.  
 

14. Setup of the communication middleware “MelfaRXM.ocx”  
The setup methods of the communication middleware(MelfaRXM.ocx) are explained.  

 
A. Appendix (Function tree)   

The functions of this software are shown as a tree format.  
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1.2. Confirming the product 

(1) The check of the package 
 

Please check if all items shown below are included in the package. 
- CD-ROM "RT ToolBox Robot Total Engineering Support Software" 
- Setup Guide 
- END-USER SOFTWARE LICENSE AGREEMENT 
- License Certification (Please make sure Product ID is printed on it) 

* Please contact the branch office or the agency if there is some shortage in the package. 
 
 
(2) Product ID 

It is necessary to input product ID when you install Version F1 or later of this software. 
 
(3) The check of media contents   

The following items are included on the CD-ROM.  
 

Doc

Setup.exe
\:

:
:
:

The files for installagion of this software

This manual(pdf)

Utility
The folder for setup of  the communication
middleware "MelfaRXM.ocx"

 
 

 
 
(4) About the communication middleware “MelfaRXM.ocx” 

MelfaRXM.ocx is the ActiveX control that communicates to robot-controller. You can create the Windows 
Application of "MELFA ROBOT" by using this control.  

You can use "MelfaRXM.ocx" in only standard version of this software. 
Please refer to "14. Setup of the communication middleware “MelfaRXM.ocx" ” about an setup of 

"MelfaRXM.ocx".  
In case of using only the function of  "RT ToolBox  Robot Total Engineering Support Software", you don't 

need to install this software. 
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1.3. Items to be prepared by user 

 
The items to be prepared by the user to use this personal computer software are explained in this section. 

 

(1) Personal computer system 
 
   Prepare the following model. 
 
   * Personal computer that runs with  

Microsoft® Windows® 98 Operating System 
Microsoft® Windows® Me Operating System 
Microsoft® Windows NT® Workstation Operating System Version 4.0 
Microsoft® Windows® 2000 Operating System 
Microsoft® Windows® XP Home Edition Operating System  
Microsoft® Windows® XP Professional Operating System 

 
Details of working environment 
Item Min. required environment Recommended environment 
CPU Pentium133MHz Pentium III 450 MHz or more (*) 
Main memory 32MB or more 128MB or more 
Hard disk 100MB of open space or more 200MB of open space or more 
Display Must have graphic function that can display SVGA (800 × 600) or 

more, and must be capable of displaying 16 or more colors. 
Disk unit CD-ROM drive 
Keyboard PC/AT compatible keyboard 
Pointing device Device that operates in Windows® environment 
Communication port Must have serial communication port that operates in Windows® 

environment. 
(Min. 9600bps: 1 port) 

(*) When you calculate cycle time with this software, please use the personal computer of greater 
performance one than that. 

 
(2) Personal computer cable 

Please prepare an RS-232C cable for connecting the controller to the personal computer. 
Model name Description 

RS-MAXY-CBL For controller's front panel 
RS-AT-RCBL For extended option box (CR1-EB3) 

For more information about the RS-232C cable specification, refer to the Standard Specifications of the 
robot in use. 

 
 

(3) Software 
Microsoft® Windows® 98 Operating System 
Microsoft® Windows® Me Operating System 
Microsoft® Windows NT® Workstation Operating System Version 4.0 
Microsoft® Windows® 2000 Operating System 
Microsoft® Windows® XP Home Edition Operating System  
Microsoft® Windows® XP Professional Operating System 
 

 
 

This software is confirmed that can be operated on the following OS. 
 

Windows® XP Professional English version 
Windows® XP Professional Germany version 
Windows® XP Professional Traditional Chinese version 
Windows® XP Professional Korean version 
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2. Preparation before use  
 

The methods of setting up this software are explained in this chapter. The setup work includes the following 
steps. 
 

i) Installing this software into the personal computer 
Æ Read "2.1 Installation methods". 

ii) Setting up the printer (Not necessary when not printing on paper) 
Æ Read "2.2 Setting up the printer". 

iii) Connecting the robot and personal computer 
Æ Read "2.3 Connecting to the robot". 

 

 

2.1. Installation methods 

The methods for installing this software are explained in this section. The software can be installed from the 
CD-ROM or from the floppy disks. 

If an older version of the "RT ToolBox  Robot Total Engineering Support Software" or the "MELFA Personal 
Computer Support software" is installed in the personal computer, always uninstall the older version before 
installing the newer version. 

 
 
 

2.1.1. Installation 
* If the OS is one of those followings, you must be logged on as an Administrator or as a member of the 

Administrators group in order to install this software. 
- Microsoft® Windows NT® Workstation Operating System Version 4.0 
- Microsoft® Windows® 2000 Professional Operating System 
- Microsoft® Windows® XP Professional Operating System 
- Microsoft® Windows® XP Home Edition Operating System 

* If an older version of the "RT ToolBox Robot Total Engineering Support Software" or the "MELFA Personal 
Computer Support Software" is installed in the personal computer already, be sure to uninstall the older 
version before installing the newer version. 

 
(1) Set this CD-ROM in the personal computer's CD-ROM drive. The Setup screen will be started up 

automatically.  
(2) If the screen does not start up automatically, carry out the following procedure. 

(a) Select the [start] button and [run] 
(b) Check the CD-ROM drive name. Input as shown below. 

 "Drive name":/Setup.exe 
(If the CD-ROM drive is "D:", this will be "D:/ Setup.exe".) 
 

 
Fig. 2-1 Run 
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2-6 Installation methods 

 
(3) Installation procedure 

 Start 

(f) Input Product ID 

 

(i) Start the program, and confirm whether 
the product was installed correctly 

(h) Installation Wizard Complete 

(a) Set the CD-ROM in PC's CD-ROM drive.

(b) Open "Setup.exe" in CD-ROM. 
(when it is not started automatically) 

(c) Starting installation Wizard 

(d) License Agreement 

(g) Choose Destination Location 

(e) Input "Customer Information" 

Finish
 

* Product ID is printed on the Certificate of License permission  
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2.1.2. Uninstallation 
In Version F1 or later of this software, Select "RT ToolBox English" with [Start]->[Setting]->[Control 

Panel]->[Add or Remove Programs], and then click on [Remove] button. 
In Version E1 or earlier of this software, Select " MELFA Personal Computer Support software " with 

[Start]->[Setting]->[Control Panel]->[Add or Remove Programs], and then click on [Remove] button. 
 

 Version F1 or later Version E1 or earlier 
  

 
Fig. 2-2 Uninstalling the application. 

       
 

When uninstalling this software, the following screens might be displayed.  There is no influence 
on other applications even if the file shown in the following is deleted. 

 
Fig. 2-3 Shared File Detected (PrgEditParts.ocx) 

 
PrgEditParts.ocx 
VisualPrgEditParts.ocx 
RoboFile.dll 
RoboOpenGL.ocx 
EZSocketRc.dll 
NarcServerApi.dll 
NarcServerApiM.dll 
UpDownBtn.ocx 

 

Please do not delete files other than the above-mentioned. Other applications might not operate when it is deleted. 
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2.2. Setting up the printer 

 
To print programs with this software, the printer must be setup. 
The method for setting up the printer is explained in this section. 

 
1) Double click on [My Computer] Æ [Printer]. 

 

Double-click

 
Fig. 2-4 Double-click “Printers” 

2) Double click on [Add Printer]. 
 

Double-click

 
Fig. 2-5 Double-click “Add Printer” 

 
3) Follow the instructions on the screen. The basic flow is as shown below. Refer to the instruction manual of 

the printer being used for details. 
i) Select the type of connected printer 
ii) Select the connected printer product name and maker 
iii) Select the port used by the printer 
iv) Set the printer name 
v) Set whether to test the printing --> Completed 
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2.3. Connecting to the robot 

The method of connecting the controller body to the personal computer is explained in this section. 
Either an RS-232-C connection or Ethernet can be used to connect the personal computer to the controller. 

The methods are explained in the following order in this section. 
1) Using RS-232-C 
2) Using Ethernet 
3) Setting the communication server 

 
* Usually, the personal computer is provided with RS-232-C as a standard. When using Ethernet, the "Ethernet 
interface" option is required on the robot controller and a network card is required on the personal computer. 
 

Caution 
Personal computer support software of D1 version or later can simultaneously connect with a 
maximum of 32 robot controllers. Please note that personal computer support software of C2 
version or earlier cannot simultaneously connect with multiple robot controllers. Also, RS-232C 
and Ethernet can be used together. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
* When using Ethernet, if communication setting is performed for unconnected robots, retry 
processing is performed frequently and, as a result, the execution speed slows down. Therefore, 
set the communication setting for unconnected or powered-off robots to “Not used.” 
* 32-robot connection is a theoretical value; when 32 robots are actually connected, it does not 
guarantee the same performance as when only one robot is connected. For example, if all of the 
32 robots are monitored, the status update slows down compared to when only one robot is 
connected. Also, such setting may affect applications that use other networks in Windows 98/Me. 

R/C 
#31 

 
R/C 
#32 

 
R/C 
#1 

R/C 
#2 

“Personal Computer Support Software” 

・・・ 

RS-232C 
（COM1） 

RS-232C
（COM2）

Ethernet(LAN)

Example of connecting multiple robot controllers 
R/C:Robot Controller
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2.3.1. Using RS-232-C 
 
1) An RS-232-C cable is used for the connection between the personal computer and controller. (For a DOS/V 

personal computer, a 9-pin connector on the robot side and a 25-pin connector on the controller side is 
used.) 

2) Connect the personal computer side of the cable to the standard RS-232-C connector (RS-232-C serial port  
 

 
Fig. 2-6 Personal computer's RS-232-C connector 

 
When connecting to a port other than the RS-232-C serial port 1, refer to section "2.3.3 Setting the communication 
server". 

 
3) Connect the controller side to the RS-232-C connector on the front of the controller. 
 

Connect here

 
Fig. 2-7 Controller's RS-232-C connector 
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2.3.2. Using Ethernet 
 

* To use Ethernet, the robot controller must be provided with the "Ethernet interface" option, and the personal 
computer must be provided with a network card. The network must also be set. 

 
Connect the modular plug to the personal computer's network card connector. 
Connect the personal computer to the network. Contact the network manager for details on setting the network 

address (IP address, Subnet Mask, default gateway, etc.) in the personal computer. 
 
Connection example: 

            
<Laptop computer>   <Desktop computer>  

Fig. 2-8 example for connection 
 

Refer to the "Ethernet Interface Option Instruction Manual" for details on connecting to the robot controller. 
 
When using Ethernet, refer to section "2.3.3 "RT ToolBox  Robot Total Engineering Support Software" 

communication settings" and change the software's communication specifications. 
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2.3.3. Setting the communication server 
 

 

Communication with the robot controller may be disabled if the communication specifications are
changed. Take special care when making changes. 

Caution 

 
 

The communication settings are made with the "communication server" in this software. 
The "communication server" is set to the following default values when installed. 

Item Value 
Communication method RS-232C 
Device No. 1 
Port COM1 
Baud rate 9600 
Data length 8 
Parity Even 
Stop bit 2 
Transmission timeout 5000 msec 
Reception timeout 30000 msec 
No. of retries 4 times 
Protocol Non-procedural 
Robot Name  

 
When the communication specifications have been changed in the robot controller or when using the Ethernet 

interface option, change the communication specifications in the personal computer with the following 
procedure. 

 
The communication server is automatically started when this software is started up. 

Note that the server is iconized when started up, so click on  on the task bar, and 
return to the original size.  

 

 
Fig. 2-9 Communication Server 

 
[Title Bar] (AA/BB) indicates that AA is the number of robot controllers connected, and BB is the number of 

robot controllers for which communication settings have been made.   
［Line State］ The connection status of the communication line with the robot is displayed. The status color 

indicates the status of the robot controller that is currently being selected. 
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Status Content Color 

Connecting Indicates that the connection with the robot has been established. Blue 
Connection 
wait 

Indicates that a communication to verify connection is being made in the 
case of RS-232C connection. 
Indicates the wait status for communication port connection in the case 
of TCP/IP connection. 

Green 

Connection 
error 

Displayed when the data reception enable signal cannot be detected 
because a cable has been disconnected or the robot has not been 
started in the case of RS-232C connection. 
Displayed when the communication port cannot be opened in the case 
of TCP/IP connection. 

Red 

Communication 
Setting error 

Displayed when the communication port cannot be opened in the case 
of RS-232C connection. This is not displayed in the case of TCP/IP 
connection 

Red 

Waiting Indicates the idling status displayed at the start of remote maintenance. Green 
 

[Communication State] The contents of communication with the robot controller are displayed.  
[Robot] Select the Robot Controller which wants to display Line State and Communication 

State. Only the Robot Controller by which a Communication setup was carried out 
is displayed. 

[Setting] button Changes the communication specifications. 
[Robot Information] 
 button 

Information on the currently connected robot can be referenced. 
Also, the robot controller selected here will be the initial value of the robot 
controller switching combo box in each tool (Version E1 or later). 

 
 

The controller selected in "Robot Controller" for the
communication server will be displayed as the initial value. 
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Communication setting 
The following type of window will open when the [Communication Setting] button is clicked on. 

 
 

Robot......................................Select the Robot Controller(1-32) for communication.  
Communication method .......Select the method to be used for communication. 

Either RS-232-C or TCP/IP can be selected. 
Select "TCP/IP" when carrying out communication with Ethernet. 
Set the robot controllers that are not connected to “Not used.” Otherwise, the 
performance of the personal computer may be degraded. Robot controller 1 
cannot be set to “Not used.” 
 

[Details] button A window for changing the communication specifications will open. The 
window that opens is different depending on whether RS-232-C or 
TCP/IP is selected for the communication method. 

[Robot controller 
 connection setting list] 
button 

The communication settings can be specified in a table format. This is 
convenient when performing communication settings for a large number 
of robot controllers at one time. 

[Set(Save and Close)] 
 button 

The communication specifications are changed and the change results 
are saved. Even when this software is started up next, communication 
will be carried out with the specifications set here. 

[Set(Close)] button The communication specifications are changed. The change results are 
not saved, so when this software is started up next, communication will 
be carried out with the previously set specifications. 

[Cancel] button The communication setting is quit without changing the communication 
specifications. 

[Top view] If this check box is set to ON, the dialog that indicates the communication 
status is displayed on top of the screen. If this check box is set to OFF, 
the dialog can be hidden. 

 
 

 

When completed setting the communication server, iconize the server by clicking on the 
button. 

The communication server will automatically quit when all of the personal computer support
software applications are quit. Thus, do not quit the server with the button. Communication 
with the robot controller will be disabled when the communication server is quit. 

Caution 
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Communication setting list 

 

(2) Select 

(1) Click 

 
 

Select the item you want to set and click the [Edit] button. A dialog box for selecting the communication 
method appears. Select a communication method, and then click the [OK] button. A communication setting 
dialog box for the selected communication method appears. 

After editing is completed, click the [OK] button. 
 
 
Robot controller switching operation using each tool 

Once the communication settings of multiple robot controllers are made, you can switch the robot controller 
you want to operate by manipulating the combo box for selecting a robot controller that is provided in each tool. 

The following figure shows the operation for “opening a program on the robot” in program editing. 
Clicking the ▼ area of the combo box displays the list of the robot controllers for which communication 

settings have been made. Select a robot controller using the mouse. 

 
 

 
 

* Do not perform duplicate communication settings for the same robot controller. 
Doing so will generate communication errors or problems such as missing program files in the 
controller. 
Example of incorrect use: Connect with the same robot controller using an RS-232C and a TCP/IP. 

* Before changing communication settings, be sure to close all the tools except the communication 
server. Otherwise, mismatching will occur in the robot controller list. 

* When connecting multiple robot controllers for use, execute the operations of the robot controllers 
only after verifying the target of operation.

Caution 
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Details setting (Only for RS-232-C) 

 
 

Port used : Select from COM1, COM2, COM3 or COM4. 
  Selection of COM1-COM8 is possible for the C1 version or later.  

 Select the port to which the cable is connected. 
Baud rate : Select from 4800, 9600 or 19200. 
Character size : 7 or 8 can be selected, but 8 should be set. 
Parity : Select from NON (none), ODD or EVEN. 
Stop bit : Select from 1, 1.5 or 2. 
Transmission timeout : The timeout time during transmission can be set. 
Reception timeout : The timeout time during reception can be set. 
No. of retries : Set the No. of times to retry communication. 
Protocol used : Select from Non-Procedural or Procedural. 
Robot name : A nickname consisting of up to 32 half-size characters can be assigned to a 

robot controller (D1 version or later). It is not required, but the controller 
name assigned here will be displayed in places where you need to select a 
robot controller. So assigning nicknames is convenient in distinguishing them 
when multiple robot controllers are connected. 

 
After changing to new settings, click on the [OK] button. The Communication Setting screen will reappear, so 

click on the [Set(Close)] button. (If the same settings are to be used the next time, click on the [Set(Save and 
Close)] button.) 

 
Set the following to perform a high-speed, stable communication:  

Baud rate : 19200 bps 
Protocol used : Procedural 

It is also necessary to change the communication settings of the robot controllers at this time.  
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Details setting (for TCP/IP) 

 

After setting the IP address assigned to the robot controller in [IP 
Address], click on the [OK] button. The Communication Setting 
screen will reappear, so click on the [Set(Close)] button. (If the same 
settings are to be used the next time, click on the [Set(Save and 
Close)] button.) 

 
Robot Information 

The information on the robot controllers for which communication settings have been made is displayed in a 
list format. 

 
If the connection has already been completed, the robot controller information is displayed after the controller 

model number. 
If the connection has not been completed, the description of a communication error is displayed in the 

controller model number field. 
Double-clicking the controller number in the list displays the information on the robot selected in the dialog 

box. 

 
[OK] button : The Communication Server screen will reappear. 
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3. Basic functions and window operations 
The functions provided with this software and the basic Windows® operation methods are explained in this 

chapter.  
 

3.1. Basic functions 

This software functions are explained in this section. 
This software has the following functions. Each function corresponds to the tools explained in Chapter 5 

and following. A list of functions (Windows) is given in "A. Appendix (Function tree) for reference". 
S/W(*1) Function Details 

STD mini

Applicable model 

Personal computer that runs on 
Microsoft® Windows® 98 Microsoft® Windows® Me 
Microsoft® Windows NT® 4.0 Microsoft® Windows® 2000 
Microsoft® Windows® XP.. 

OK OK

Editing  
functions 

* MELFA BASIC IV or MOVEMASTER command(*3) compatible 
* Simultaneous display of multiple editing screens 
* Command input, command description 
* Editing of position data 
* File operation 

(Writing to controller, floppy disk and personal computer) 
* Search, Find in files and Replace function (With character, line 

No. or label) 
* Copy, cut, paste, insert (per character, line), undo (per 

command statement, position variable) 
* Line No. automatic generation, renumbering 
* Batch grammar check 
* Command template 
* Position variable batch editing 
* Position variable template 
* Print, print preview 

OK OK

Managem
ent 
functions 

* Program file management 
  (List, copy, move, delete, content comparison, rename, 

protect) 
OK OK

Program  
editing functions 

Debug  
functions 

* Direct editing of programs in controller 
* Confirmation of program operation (step execution, direct 

execution) 
* Cycle time measurement 

OK OK

Simulation function (*2) * Confirmation of robot program operation with off-line simulation using CG 
[Computer Graphics]. 

* Calculation of cycle time 
OK - 

Monitor functions * Robot movement monitor (robot operation state, stop signal, error 
monitor, program monitor (execution program, variables), 
general-purpose input/output signal (forced output possible), 
dedicated input/output signals, movement operation (movement 
range, current position, hand, etc.) 

* Operation monitor (operating time accumulation, production information, 
robot version) 

* Servo monitor (position, speed, current, load, power) 

OK OK
(*5)

Parameter editing function * Parameter setting OK OK
Backup/Restore * Batch backup and Batch Restore OK OK
Remote maintenance 
function 

* Monitoring and maintenance of robot at remote location using telephone line.
  (A separate modem is required to use this.) OK OK

Position repair(*4) Support for recovery from origin point deviations OK OK
Maintenance forecast(*4) Maintenance Period Forecast function OK OK

(*1) Software shows the following : 
STD : "RT ToolBox  Robot Total Engineering Support Software" (standard version) 
mini : "RT ToolBox  Robot Total Engineering Support Software mini" 

(*2) The simulation function is compatible only with the standard version(STD). 
(*3) MOVEMASTER command is only available for certain types of robot. Please verify that the type of robot that you are using is listed in 

the "Command List " of "Separate Volume: Standard Specification" . 
(*4)These functions are supported by version E1 or later of this software. However, these functions are only available for certain types of 

robot and for certain controller software version. Please refer to "12. Position Repair Support Tool" and "13. Maintenance Forecast" for 
details. 

(*5) The robot 3D monitor function in the "Movement State" is compatible only with the standard version(STD). 
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3.2. Basic Windows operations 

The basic mouse operations of Windows, required when a first-time user of Windows is using this software 
are explained in this section. 

 

(1) Mouse operations 
 

Selecting a menu 
When selecting a menu, move the mouse cursor to the menu characters, and then press the left mouse 

button. A list will appear from the selected menu, so while holding down the left mouse button, move the 
mouse cursor to the item to be selected, and then release the left button. 

 

1. Press left button at menu. 

2. Move mouse to position of item to select while pressing left button.

 
 
Click 

This means to press the left mouse button once. This is used to press buttons, etc. 
 

Double-click 
This means to press the left mouse button twice quickly. This is used to select an item from the list.  
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4. Starting use  
 

This chapter explains the series of software operations in a tutorial method for first-time users of this software. 
 
Here, a robot program will be created using this software, and the program operation will be confirmed with 

simulation. Then, the program will be downloaded to the robot controller and the operation confirmed by 
operating the actual robot. 

 

4.1. Starting 

 
(1) Connect the cable with the following procedure. 

Connect the personal computer and controller with an RS-232C 
cable(RS-MAXY-CBL or RS-AT-RCBL). 
Connect the personal computer side to the standard RS-232C connector 
(RS-232C serial port). 
Connect the controller side to the RS-232C connector on the front of the 
controller. 

(2) Turn the controller power ON. 
(3) Start up this software with the following procedure.  

Turn the personal computer power ON. The following Main screen will 
start up automatically. If the screen does not start up, select the Windows 
[Start] button, and then... 
<Version F1 or later> 
[Programs] ->  [MELSOFT Application] -> [RT ToolBox] -> [RT ToolBox]. 
<Version E1 > 
 [Programs] -> [MELFA ENG](or [MELFA mini ENG]) -> [CRn-500 PC 
Support Software]. 
<Version D2 or earlier> 
 [Programs] -> [MELFA ENG](or  [MELFA mini ENG]) ->  [MELFA PC 
TOOL]. 

 

 
 

Fig. 4-1 Main screen 
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4.2. Creating a program 

 
Next, try editing an actual program. 

 

(1) Starting the program editing tool 
Click on the [Program Edit] button on the Main screen. The program editing tool, as shown below, will start up. 

 

The editing screen will appear. 

 
Fig. 4-2 Entire screen from Main screen to Program editing screen 

 
 

(2) Newly creating a program file 

To create a new program file, first click on [New] under the [File] menu, or click on the button. 
The following type of editing screen will appear. 

 
 

Command editing screen 

Position variable editing screen

 
Fig. 4-3 Editing screen 
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(3) Editing the program 
Here, a simple program using the three positions P10, P11 and P12 will be created. The program contents will 

move the robot in order between the three points. The list is shown below. 
 

Program name: P100 
 

10 GETM  1  ‘Declare to move mechanism No. 1 robot 
20 MOV  P10  ‘Move to position P10 
30 MOV  P11 ‘Move to position P11 
40 MOV  P12 ‘Move to position P12 

 
 

 
An example for inputting the first line is shown. The upper side of the editing window is the program command 

statement editing screen. 
Input as shown below using the keyboard, and then press the Enter key. 

 

 
(1st line: "10 GETM 1") 

 
The cursor will move to the next line. To change the contents of the program line, change the contents at the 

line, and then always press the Enter key at that line. 
 

 Input line Enter! 

 
(Press Enter key) 

Input the remaining program in the same manner. 
 

 
(Editing window containing the following program.) 
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4.3. Teaching a position 

 

(1) Editing the position variable 
 

Next, edit the values of the position variables P10, P11 and P12 input in the program command statement to 
the following values. The values marked with an × in the table are not input here.  

 

Caution: The following values are for
the RV-20VA type robot.

 
Position variable name X Y Z A B C L 1 L  2 Flag1 Flag2

P10 1060 -680 870 × × × × × 6 0 
P11 900 300 1800 × × × × × 6 0 
P12 933 0 1588 × × × × × 6 0 

（Unit：mm）  
 
(2) Add a position variable.  
 
The lower side of the editing screen is the position variable editing screen.  

 

List of Cartesian type variables 

List of joint type variables 

 
Fig. 4-4 Position variable editing screen 

 
Input the position variable P10 value as shown below.  
When the [Add] button is clicked on, the Position variable addition screen will appear.  
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Fig. 4-5 Addition screen 

 
 
Input the variable name "P10" in the [Variable Name] area.  

 
(Variable name area) 

 
Input each value (X: 1060, Y: -680, Z: 870, Posture; 0, Multi-rotation: 0) in the [X] [Y] [Z] [Posture] and 

[Multi-Rotation] areas.  

 
(Value input area) 

 
In this case, the [Additional axis 1] [Additional axis 2] [A] [B] and [C] values are not defined, so remove the 

checks. 

Remove check

 
(Removing the check) 

 
heck the described details, and click on the [Add] button. The position variables will be registered into the program, 
and the P10 position variable will appear in the position variable list as shown below. 
 

 
Fig. 4-6 State with P10 in list 

 
Add the remaining two position variables in the same manner. 
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4.4. Confirming the operation with simulation 

 
Next, try confirming the operation of the created robot program using simulation. Select [Execute, Stop] → 

[Automatic Operation] from the [Simulation] menu. 
 

Select

 
Fig. 4-7 Simulation menu 

 
The following type of robot type and hand/workpiece setting screen will appear. In this case, select "RV-6S" 

from the model list, and click on the [OK] button.  
 

 

Select the Type and 
Robot 

Not used in this case 

 
Fig. 4-8 Model and hand/workpiece setting screen 

 
The following type of simulation screen will appear, and simulation of the robot will start. Confirm that the robot 

moves as written in the program. 
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Try changing the viewpoint. 
The viewpoint can also be changed by the following
mouse operations: 
 
• Dragging left button 

left and right → Rotation of Z-axis center 
up and down → Rotation of X-axis center 

• Dragging left + right button 
left and right → Rotation of Y-axis center 

• Dragging right button 
up, down, left and right → Move 

• Dragging left button + [Shift] key 
up and down → Enlargement/reduction 

 
Fig. 4-9 Simulation screen 

 
Did the robot move correctly? If it moved correctly, try changing the position variable value and moving the robot. 
Refer to the Robot Language Instruction Manual enclosed with the controller for the definitions of the position 
variables. 
 
 

When not using the RV-6S type robot, change the program position variable values to match the 
model being used. Then check the movement with simulation, and then check the movement with 
the actual robot, as explained in the following section. 

Caution 
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4.5. Saving the program 

 
After confirming the robot movement with simulation, save the program in the controller with the following 
procedure.  Here, the program will be saved in the controller with the name "100". 

Click on [Save As->Robot] under the [File] menu, or click on the  button. A screen for designating the 
program. 
A window for designating program name appears when [Save As -> Robot] is selected. 

 
Fig. 4-10 File dialog 

When  button is clicked, a dialog shown on the right appears.  Select [ROBOT] and click on the [OK] button. 
(Caution: When saving the program in the personal computer, click on the radio button next to "PC".) 

 
Fig. 4-11 Select a target 

 
Input "100" in the [File Name] area, and then click on the [OK] button. 
To save the program in a robot controller other than robot controller 1, select the robot controller you want to save 
the program to. 

 
Fig. 4-12 File name and OK button 

A dialog showing the save work progression will appear, and the edited program will be saved in the robot 
controller. 

 
Fig. 4-13 Screen announcing save 

 



4. Starting use 
 

 Exiting the editing screen 4-29 

4.6. Exiting the editing screen 

Click on "Close" under the [File] menu, or click on the [x] button on the editing screen. The editing screen will close. 
This completes the program editing work. 

 

 
Fig. 4-14 "Close" in menu and Exit button 

 
 



4. Starting use 
 

4-30  Confirming the movement 

4.7. Confirming the movement 

Try starting the "P100" program with the robot controller's operating panel. Did the program run as anticipated? 
 

Try monitoring the robot movement 
When the [Monitoring Tool] button on the Main screen is clicked on, the monitoring tool will start. 
Click on [(4) Program Monitor] to start the program monitor.  

 
Fig. 4-15 monitor menu 

 
Look at the program monitor and confirm the robot movement and program. 
 

 
Fig. 4-16 Program monitor 
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4.8. Exit the operations 

 
Did the robot move correct? Finally, exit this software. 
 
(1) Exit the "RT ToolBox  Robot Total Engineering Support Software" 
Exit the program editing tool and monitoring tool. Each tool will exit when [Exit] is selected from under the [File] 
menu. 
 

 
Fig. 4-17 Exiting the application 

 
(2) Exit window 

Exit windows by selecting [Shut Down…] -> [Shut down the computer?] -> [OK] under the [Start] button. Do not 
turn the personal computer off until a message indicating that it is okay to turn the personal computer power OFF 
appears on the screen. Depending on the personal computer, the power may turn OFF automatically.
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5. Program editing tool 
 
The detailed operation methods of this software are explained for each tool in this chapter. 
 
The methods of operating the program editing tool are explained in this section. 
 
With the program editing tool, the robot program is created, the robot movement is debugged, and simulation (only 
for standard version) is carried out. 

 
Fig. 5-1  Program editing tool 
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5.1. Setting the screen 

The following settings can be customized with the program editing tool. 
 

(1) Font The font used with the program editing tool can be changed. 
(2) Variable display 

area setting 
The display ratio of the "orthogonal coordinate type variables" and the "joint 
coordinate type variables" on the Position Variable Edit screen can be changed.

(3) Syntax check 
setting 

Whether to check the syntax, and whether to display messages if there are no 
syntax errors when saving the program can be set. 

(4) (4) Programming 
Language 

The robot programming language can be changed. The language which can be 
switched is MELFA-BASIC IV and Movemaster-command. (Ver.B1 or more) 

(5) History  The number of the document used recently displayed on a [File] menu is 
changed. (Ver.C2 or more) 

 
[Setting method] 

Click on the menu "File" - "Close", and close all of the program edit tool programs. 
These settings can be made from the "View" menu. 

 

(1) Select “Close” 

(2) Select “View”  

 
Fig. 5-2 Setting method 

 
 

5.1.1. Font 
The font used with the program editing tool can be changed.  Click on the menu "View" - "Font". 

 

 
Fig. 5-3 Set Font 
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5.1.2. Variable display area setting 
The display ratio of the "Cartesian type variables" and the "joint type variables" on the Position Variable Edit 

screen can be changed. 
 

 

 
Fig. 5-4 Proportion of Window 

 
 
 

5.1.3. Syntax check setting 
Whether to check the syntax, and whether to display messages if there are no syntax errors when saving the 

program can be set. 
 

 

 
Fig. 5-5 Syntax check setting 

 
When each item is set, the following will occur. 

Always When the edited program is saved, the syntax will always be 
checked. 

Confirm A message box confirming whether to check the syntax will 
appear when the edited program is saved. 

Syntax check 

No Check The syntax will not be checked when the edited program is 
saved. 

Display If there are no errors in the syntax check, the message "No 
syntax errors" will appear. 

Confirmation when 
there is no error. 

Hidden If there are no errors in the syntax check, no message will 
appear. 
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5.1.4. Program Language 
The robot programming language can be changed.  The language which can be changed is as follows.  

MELFA-BASIC IV 
MOVEMASTER command 

 
This change is possible by this software Ver.B1 or more. 
However, MOVEMASTER command has the limitation in the robot model which can be used. 
Check the "Standard Specifications", etc., to confirm that the model in use is compatible with the 

MOVEMASTER command.  
 

 
Fig. 5-6 Language selection  

 
If the language to be used has been changed in the Language Settings, end program editing once, and then 
restart. 
 
 

When MOVEMASTER command is used, the simulation function cannot be used. 
Caution 

 
 
 
 

5.1.5. History 
The number of the document used recently displayed on a [File] menu is changed. 
Please input the numerical values from 1 to 16. 
This is possible by this software Ver.C2 or more. 

 

 
Fig. 5-7 history 

 
In order to confirm change, end program editing once, and then restart. 
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5.2. Editing screen 

 
The methods of displaying and operating the editing screen are explained. 
 
Select [New] under the [File] menu to display the program editing window. 

 
Fig. 5-8 New 

 
 

Move up or down

Command editing screen 

Position variable editing screen

 
Fig. 5-9 Displaying the program editing window 

 
The upper side is the program command statement editing window, and the lower side is the position variable 

editing window. 
 
To change the position of the upper/lower screen division, drag the boundary line with the mouse. This is 

handy for enlarging the command editing screen when there are many command statement lines, etc. 
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To edit the program on multiple editing windows, select [New Window] under the [Window] menu. This function 
is handy for viewing both the head and end of the program when editing a program having many lines. 

 
 

Set M1 at the start of the program Branching condition for M1 at end of program 

 
Fig. 5-10 Multiple editing windows 

 
 

To close the program editing window, select [Close] under the [File] menu. 

 
Fig. 5-11 Close 
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5.3. Editing mode 

The program editing tool's editing mode is explained in this section. 
The program editing window's editing modes include the "BASIC Editor" for persons familiar with the BASIC 

language editing tool used with the old controller, and the "Line No. hide mode" for persons familiar with 
Windows wordprocessing operations. 

 
When the normal program editing window is started up, the "BASIC Editor" is entered. These two editing 

modes can be changed freely at any time. 
 

5.3.1. BASIC editing mode 
This mode shows the robot program line Nos., and is intended for users familiar with the BASIC language 

editing tool used with the old controller. The robot program can be edited at the required line No. The AUTO 
function and renumbering function can be used to edit the line No. 

 

Line No. is manually input 

 
Fig. 5-12 BASIC editing mode screen 

 
 
 
 

5.3.2. Line No. hide mode 
This mode does not show the robot program line Nos., and is intended for users familiar with Windows 

wordprocessing operations. The program commands can be edited without inputting the line No. The stop 
position is shown on the left edge. When the edited program is saved, the line Nos. are automatically assigned. 

 

Line No. does not need to be input

 
Fig. 5-13 Line No. hide mode 

 
Line No. hide mode cannot be selected Movemaster-Command. 
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5.3.3. Changing the editing modes 
The editing mode can be changed as explained below. 
 
→ When [BASIC Editor] is selected from under the [Window] menu, the currently active editing program 

window will change to the BASIC editing mode. 
 
→ When [Line No. hide mode] is selected from under the [Window] menu, the currently active editing 

program window will change to the line No. hide mode. When changing from the BASIC editing mode, the 
line no. assigned to the program command statement argument will be automatically converted into a 
label. Note that once the line No. is converted into a label it cannot be returned to a line No. 

 
 

Change to BASIC editing mode

Change to line No. hide mode

 
Fig. 5-14 State of mode conversion 
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5.4. Opening a program 

The methods for opening and saving a program are explained in this section. 
 
The operations related to opening, closing and saving an editing program are all carried out from the [File] 

menu or tool chip (buttons under menu). 
 

 

New Open Save 

 
Fig. 5-15 [File] menu and tool chips 

 
 

The contents of the program changed with editing are not saved unless "Save" is executed. There is no 
particular limit to the number of program files that can be opened. 

 
 

5.4.1. Opening programs on a PC 
To open a program on a PC, select [Open PC] under the [File] menu. It is also possible to open several files 

simultaneously by pressing the [Ctrl] key and making selection using the "mouse." 

 
Fig. 5-16 Opening programs on a PC 
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5.4.2. Opening a program on a robot controller 
A program in the controller can be opened with the normal open method and with the debug open method. 
From Version E1 of this software, when reading the program on the robot controller to the personal 

computer, read items (instruction statements, position variables, program external position variables) can be 
specified. (However, this function can only be used with Version H1 or later of the robot controller software.) 

For more information about read items, see the next section. 
 

Normal open :  
Read the program on the robot controller to the personal computer. 

A window shown below appears when [Open Robot] is selected.  It is also possible to open several files 
simultaneously by pressing the [Ctrl] key and making selection using the "mouse."   

 

 
Fig. 5-17 Opening programs on a robot 

 
Updates to the latest information when [Refresh] button is clicked. 

Refresh the information on this window when changing a file with teaching box, etc. or when connecting to a 
different robot controller. 

If multiple robot controllers have been connected, the robot controllers can be switched by manipulating the 
combo box labeled “Robot.” 
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Debug open :  
  The contents of the program changed with editing are reflected immediately. The program file contents will 

be changed, even when "Save" is not executed. Depending on the opened program, the robot can be directly 
operated (step execution, direct execution). Only one program can be opened, and the editing mode is limited 
to the BASIC editing mode. To open a program, select [Debug] under the [File] menu. 

 
Fig. 5-18 Select debug program 
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5.4.3. Read items when opening the program on the robot controller 
Read items in the robot program can be set by categorizing them into instructions, position variables and 

program external position variables. (The function for specifying read items can be used with Version E1 or later 
of this software and Version H1 or later of the robot controller software. The function for specifying write items 
can be used with Version E1 or later of this software regardless of the version of the robot controller software.) 

 
The initial values of the read items are as shown in “Fig. 5-19 Read Items” 

 

 
Fig. 5-19 Read Items 

 
"Table 5-1 Program External Position Variable Read Operation" shows the operation to read program 

external position variables. (For more information about program external position variables, refer to the 
separate volume, "Detailed Guide to Functions and Operation.") 

 
Table 5-1 Program External Position Variable Read Operation 

Read Item  
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Position variable, joint variable
(P_01, J_02, etc.) 

(MOVEMASTER command : 
901-999) 

Position array variable,  
joint array variable 

(P_100( ), J_102( ), etc.) 

   

   

Reads only the external 
position variables (position 
variables, joint variables) used 
in instruction statements. 

Reads all elements used in 
instruction statements. (*1) 
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Reads all external position variables (position variables, joint 
variables, position array variables, joint array variables). 
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Reads all external position variables (position variables, joint 
variables, position array variables, joint array variables). 

R
ob

ot
 c

on
tro

lle
r's

 s
of

tw
ar

e 
ve

rs
io

n 

Ve
r. 

G
9 

or
 

ea
rli

er
 This function cannot be used. 

 
*1:  If only P_100(1) is used in an instruction statement, all of P_100(1) to P_100(10) will be read. However, the number of 

effective elements depends on the software version of the robot controller in use. 
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5.5. Closing and saving a program 

Select the [Save As -> PC] or [Save As -> Robot] of the [File] menu in order to save an edited program.  
Then the saving window appears accordingly.  Name the file and save it. 

 
To save a program you have edited, select [Save on Personal Computer] or [Save on Robot] from the [File] 

menu. When the corresponding screen for the selected save destination opens, save the program by 
assigning a file name. 

From Version E1 of this software, when saving programs on the   robot controller, write items (instruction 
statements, position variables, program external position variables) can be specified. 

For more information about write items, see “5.5.4 Write Items When Saving on the Robot Controller" 
 

 
Fig. 5-20 File menu 

 
 

5.5.1. Save 
To save a program you are editing, select [Save] from the [File] menu, or click .  
In Version E1 or later of this software, write item confirmation (see the figure below) appears. The items 

checked here are the same as the read items. In any other versions, instruction statements and position 
variables are saved by overwriting without displaying the write item confirmation. 

 
Fig. 5-21 Written item 
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5.5.2. Save on Personal Computer 
To save a program on the personal computer, select [Save on Personal Computer] from the [File] menu. 

 
Fig. 5-22 Save on Personal computer 

 
 
 

5.5.3. Save on Robot 
To save a program on the robot controller, select [Save on Robot] from the [File] menu.  
 

 
Fig. 5-23 Save on Robot 

 
The write items when saving on the robot controller can be used in Version E1 or later of this software.  
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5.5.4. Write Items When Saving on the Robot Controller 
When saving a robot program on the robot controller, write items can be set by categorizing them into 

instructions, position variables and program external position variables. (The function for specifying write items 
can be used with Version E1 or later of this software.)  

 
The initial values of the write items are the same as the read items when reading a program. When a new 

program is created, the initial values are as shown in Figure 5-24, "Write Items."  
 

 
Fig. 5-24 Write Items 

 
The following shows the save operation to the robot controller when only instruction statements and position 

variables are specified.  
 <Example> When the following programs will be edited on the robot controller and the

personal  
computer:

<< Program on the robot controller >>
10 MOV  P1 
20 MOV  P2 
30 MOV  P3 
40 END 
P1=( 400.000,   0.000, 100.000, , , 90.000)(4,0) 
P2=(   0.000, 400.000, 150.000, , ,  0.000)(4,0) 
P3=(-351.704, -49.369,  22.000, , ,-95.168)(0,0) 
P4=( 276.499,-599.066, 264.966, , , 29.170)(0,0) 

<< Program on the personal computer >>
100 MOV  P1 
200 MOV  P2 
300 MOV  P5      ‘ <- Change 
400 END 
P1=( 400.000,   0.000, 100.000, , ,-90.000)(4,0) 
P2=(   0.000, 400.000, 150.000, , ,  0.000)(4,0) 
P3=(-351.704, -49.369,  22.000, , ,-95.168)(0,0) 
P5=( 535.786, 295.021, 102.000, , ,148.420)(0,0) 

 
(1) When only instructions are written 

Only instruction statements are rewritten. Position variables are not changed. 

<< Program on the robot controller >>
100 MOV  P1 
200 MOV  P2 
300 MOV  P5 
400 END 
P1=( 400.000,   0.000, 100.000,,, 90.000)(4,0) 
P2=(   0.000, 400.000, 150.000,,,  0.000)(4,0) 
P3=(-351.700, -49.370,  22.000,,,-95.170)(0,0) 
P4=( 276.500,-599.070, 264.970,,, 29.170)(0,0) 

 

Only instructions are rewritten.

Not changed

 
 
(2) Only when position variables are written  

<< Program on the robot controller >>
10 MOV  P1 
20 MOV  P2 
30 MOV  P3 
40 END 
P1=( 400.000,   0.000, 100.000,,,-90.000)(4,0) 
P2=(   0.000, 400.000, 150.000,,,  0.000)(4,0) 
P3=(-351.700, -49.370,  22.000,,,-95.170)(0,0) 
P4=( 276.500,-599.070, 264.970,,, 29.170)(0,0) 
P5=( 535.790, 295.020, 102.000,,,148.420)(0,0) 

 

Not changed

The position variables on the personal 
computer are overwritten. However, the 
position variables that do not exit on the 
personal computer but exit on the robot 
controller are left intact (reference). 
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5.5.5. Precaution for saving program in controller 
 

Precautions for saving program in controller 
When writing (saving) the robot program in the controller, first the program having the same name

from the controller is deleted, and then the new program is written in. 
With this, if an error occurs or the communication is canceled while transmitting the program from the

personal computer rot the controller, the original program in the controller will be erased. 
In this case, the program can be recovered with the following procedures. 

 
【Countermeasure】 

* If the program to be transmitted is being edited with the personal computer, remove the cause of 
the error, and then save again. 

* If the program editing has been exited: 
A backup file is created in the folder where the personal computer support software is installed. 
If the folder was not changed during installation, it is 
  Version F1 or later = C:/Program Files/MELSOFT/RT ToolBox E/ 
  Version E1 or earler = C:/Program Files/Melfa/. 
The name of this backup file has a Temp added before the name that was to be saved. (Ex.: 
TempOOO) 
Correct the file name with Explore, etc., and open the file with program editing, and then save 
the file. 

[Correcting the file name] 
Temp○○○  
    ↓ Delete Temp from TempOOO, and add ".prg" as the extension. 
○○○.prg 

Caution 

 
 

 

Precautions when using user defined external variables 
When creating a program using user defined external variables, first define the variables in the base 

program. 
A program using variables that have not been defined in the base program will not be stored in the 

robot controller. (This will result in the “undefined variables error” when the program is being written to 
the robot controller).  

 
See the Controller INSTRUCTION MANUAL for more information on the base program and user 

defined external variables. 

Caution 

 
 

 

If the user edits (changes any one portion of) the program 
within the robot controller and attempts to close the program 
without writing to the controller, a message will appear to 
confirm if the changes need to be written to the controller (see 
the figure on the right).  

Select “Yes” if writing the data to the controller. Select 
“Cancel” to end the process of closing the program. 

 

However, with version E1 or later, if all of the “Write items” are not 
selected (see the figure on the right) when saving the program to the 
controller, the confirmation message mentioned above will always be 
displayed when closing the program. 

 

Caution 
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5.6. Editing the program 

The methods of editing a program are explained in this section. 
 

5.6.1. Program language 
The MELFA-BASIC IV, or MOVEMASTER command language is used. Refer to the controller's language 

instruction manual for details on the command grammar and format, etc.  
 
The following example shows the case when the MELFA-BASIC IV language has been selected.  
 

 

5.6.2. Registering a program command statement 
Input the command statement as shown below.  

 
For BASIC editing mode:  

Input the command statement after the line No., and input by pressing the ENTER key.  
 

Input line return!

 
Fig. 5-25 For BASIC editing mode 

 

For line No. hide mode: 
 Input only the command statement, and input by pressing the ENTER key.  

 

Input line return!

 
Fig. 5-26 For line No. hide mode 

 

 

If the ENTER key is not pressed to input the command statement, it will not be recognized as a
robot program. 

 
All characters except comment text and character string data (enclosed by ") are automatically 

converted into uppercase characters 

Caution 
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5.6.3. Deleting a program line 
Use the following procedure to delete a designated line No. line from the program.  
For BASIC editing mode: Describe only the line No., and then press the ENTER key.  

 

 
Fig. 5-27 Deleting a program line 

 
For line No. hide mode: Delete the command statement by pressing the Backspace key or Delete key.  

 

 

 

 

5.6.4. Describing a comment statement 
To write a comment statement, input " ‘ " at the head of the command statement, and then input the 

comment character string. (A comment can be input after the command statement.)  
 

 

Input the comment after ""
A comment can be input after a command statement

 
Fig. 5-28 Example of inputting a comment statement 

 

 

 

 

5.6.5. Inputting a position variable (Only for BASIC editing mode) 
By inputting a position variable definition following the robot program grammar as shown below, the P type 

and J type position variable can be input.  
 (When using the line No. hide mode, input from the position variable editing window.)  

 

The input position variable will appear in
the list on the position variable editing
screen. 

 
Fig. 5-29 Inputting a position variable 
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5.7. Editing the position data 

The methods of editing the position variables are explained in this section.  
 
The position data is edited on the position data editing screen. The list on the top is for the orthogonal 

coordinate type variables, and the list on the bottom is for the joint coordinate type variables.  
The method to display array variables differs between Version D2 or earlier and Version E1 or later of this 

software.  
 

< Version E1 or later > 
The elements of array variables are expanded and then displayed.  

 

Orthogonal coordinate type variables

Joint coordinate type variables 

 
Fig. 5-30 Position variable editing screen (E1 or later) 

 
 

< Version D2 or earlier > 
Only the name of the array variable is displayed.  

 

Orthogonal coordinate type variables

Joint coordinate type variables 

 
Fig. 5-31 Position variable editing screen (Version D2 or earlier) 
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5.7.1. Editing the position variable 
 

(1) Adding a position variable  
Click on the "Add" button. The following position variable addition dialog will appear. Select the orthogonal 

coordinate type or joint coordinate type. The element value with a checked box is defined. Input each element 
value and position variable name, and then click on the [OK] button.  

 
Input position variable name 

Select coordinate type 

Input each element 

If the coordinate does not have a 
check, the robot’s current position 
will not change. 

Reads the current position of the 
robot. 

 
Fig. 5-32 Position variable addition dialog 

 

 
The unit of the element being used differs according to the robot being used. Refer to the 

instruction manual of the respective robot. 

 

Caution 
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(2) Changing the position variable 
Select a variable from the position variable list and click on the "Change" button, or double-click on the 

position variable to be changed. The following dialog for changing the position variable will appear. The 
element value with a checked box is defined. Input each value and then press the [Update] button to change 
the value.  
 

Input each value. 

If the coordinate does not have a 
check, the robot’s current position 
will not change. 

Reads the current position of the robot.

 
Fig. 5-33 Position variable addition dialog 

 

 
The unit of the element being used differs according to the robot being used. Refer to the 

instruction manual of the respective robot.) 

 

Caution 

 
 
 

 

(3) Deleting a position variable 
Select a variable from the position variable list, and click on the [Delete] button. The selected position 

variable will be deleted.  
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5.7.2. Editing a position variable array 
The methods to display, add, change and delete position array variables differ between Version D2 or 

earlier and Version E1 or later of this software. 
 
(1) Adding position array variables 

 
< Version E1 or later > 

Add position array variables and specify an array name and element number for each variable name.  
Position array variables that have been added and registered are expanded and then displayed in a list. 
 
When writing to the robot controller, always describe a DIM declaration in an instruction statement. If there is 

no DIM declaration, an error will occur when writing to the robot controller. 
 
 
  

Array variables are expanded 
and then displayed 

An array declaration is required. 
When describing in an instruction statement, array elements will not be
automatically added to a position variable area. Add each of the array 
elements you will be using. 

 
Fig. 5-34 Registering position array variables (Version E1 or later) 

 
 

< Version D2 or earlier > 
To add a position variable array variable, input a DIM command statement that defines the position variable 

array variable in the command editing window. The name and No. of array elements of the input position array 
variable will appear in the position variable list. 

 The array variable will be added. 

Input with enter. 
 

Fig. 5-35 Inputting by editing the command, and adding to the list 
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(2) Changing the position array variable 
 

< Version E1 or later > 
Select an array variable from the position variable list and click the [Change] button, or double-click the 

position array variable you want to change. The position variable change screen appears. 
 

 

 
Fig. 5-36 Changing the position array variable (Version E1 or later)  

 
 

< Version D2 or earlier > 
Select the array variable from the position variable list and click on the "Change" button, or double-click on 

the position array variable to be changed. The following dialog for changing the position variable array will 
appear. 

 

 
1. Select array variable with mouse.

2. Click on “Change ”button”.

3. Select array name to change. 

4. Select element, and click on “Change value” button.

 
Fig. 5-37 Changing the position variable array element 

 
Select the position variable to be edited from the list on the left, and then select the element to be changed 

from the array element list on the right. Then, click on the "Change value" button, or double-click on the 
position array variable to be changed. A position variable change dialog will appear in the same manner as for 
the normal position variable. 
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(3) Deleting a position array variable 
 

 To delete position array variables, delete the "DIM" declaration in an instruction statement.
Even if position variables have been deleted in this software, when a program in which a "DIM" declaration 

is described is written into the robot controller, these array position variables will remain as component 0. 
 

 
 

 
< Version E1 or later > 

Select the array variable from the position variable list, and click on the "Delete" button. Only element of 
selected array variable will be deleted. 

 

 
Fig. 5-38 Deleting a position array variable (Version E1 or later) 

 
 
< Version D2 or earlier > 

Select the array variable from the position variable list, and click on the "Delete" button. All elements of the 
selected array variable will be deleted. 

 
 Select array variable, and click on [Delete] button.

 
Fig. 5-39 Deleting a position array variable(Versin D2 or earlier) 
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(4) Copying and pasting the position array variables 
If a variable is selected from the position variable list and right-clicked with the mouse, the menu is displayed. 

If "Copy" is selected from the menu, the contents of the variable are copied into the clipboard. If the mouse is 
right-clicked and "Paste" is selected on the desired position edit screen, the variable can be pasted on another 
edit screen. 

  

 
Fig. 5-40 Copying and pasting the position array variables 

 
If the same variable name is found, the overwrite confirmation dialog is displayed. Select whether to 

overwrite or copy after changing the name. 

 
Fig. 5-41 Confirming of Position variable paste 

 
 

The operation when copying position array variables differs between Version D2 or earlier and 
Version E1 or later of this software. 

 
< Version E1 or later > 

Position array variables can be copied for each element. They can be copied even if the definition 
(DIM instruction) of position array variables has not been described, but an error will occur if there is 
no DIM declaration when writing to the robot controller. 

The confirmation to overwrite position array variables is also performed. 
 

< Version D2 or earlier > 
The array variables can be copied, however, it is necessary to define the array variables of the 

position variables by the DIM command on the command edit window in advance.  
Please note that this software does not display the message of the overwrite confirmation when 

the array position variable is overwritten.  

Caution 
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5.8. Editing auxiliary functions 

 
The editing auxiliary functions, helpful for editing commands, are explained in this section.  
 
The editing auxiliary functions such as copy, cut, insert, search, replace and jump can be used from the 

[Edit] menu and [Tool] menu.  
  

 

 
Fig. 5-42 Edit and Tool menus 

 

5.8.1. Copy 
The character string selected with the mouse is copied. When a range over several lines is selected with the 

BASIC editing mode, line copy will be executed.  
To copy, select [Copy] under the [Edit] menu.  
By using the paste function described later, the copied character string can be pasted into another section of 

the program.  
 

1. Select character string with mouse. 2. Select “Copy”. 

 
Fig. 5-43 Copy 
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5.8.2. Line copy (Only BASIC editing mode) 
The lines containing the selected range are copied. 
To carry out line copy, select [Line Copy] under the [Edit] menu. 
By using the paste function described later, the copied character string can be pasted into another section of 

the program. 
 

1. When “Line Copy” is designated. 

2. All Lines are copied. 

 
Fig. 5-44 State of line copy 

 

 

 

 

5.8.3. Cut 
The character string selected with the mouse is cut. When a range over several lines is selected with the 

BASIC editing mode, line cut will be executed. 
To cut, select [Cut] under the [Edit] menu. 
By using the paste function described later, the cut character string can be pasted into another section of the 

program. 
 

1. Select character string with mouse. 

2. Designate “Cut”. 

3 The designated character sting is cut. 

 
Fig. 5-45 Cut 
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5.8.4. Line cut  (Only BASIC editing mode) 
The lines containing the selected range are cut. 
To carry out line cut, select [Line Cut] under the [Edit] menu. 
By using the paste function described later, the cut character string can be pasted into another section of the 

program.  
 
1. Select character string with mouse. 

2. When “Line Cut” is designated.

3. The designated lines are cut. 

 
Fig. 5-46 Line Cut 

 
 

5.8.5. Paste 
The character string or line that has been copied or cut is pasted into the selected range. When line paste is 

carried out, the line Nos. are automatically reassigned so that the lines fit into the paste range. (Only in BASIC 
editing mode) 

To carry out paste, select [Paste] under the [Edit] menu.  
 1. Select paste range. 

2. When “Paste” is designated. 

 
Fig. 5-47 Paste dialog and state of pasting 
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5.8.6. Search 
The designated character string is searched for. The search range can also be designated. 
Select [Search] under the [Edit] menu to display the Search screen. 

 
 

 
Fig. 5-48 Search dialog 

 
[Search Next] : Each time this button is clicked on, the next character string will be searched for. 
[List display] : The results of searching the designated range will appear in the list. 
 

If the list display is clicked, the window is enlarged automatically. By double-clicking the search result, or 
clicking [Jump] after selecting, the list moves to the corresponding command line. 

 

 
Fig. 5-49 Search result list display 
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5.8.7. Find In Files 
The specified character string is searched from files. (This function corresponds after a version C2.)  
To display the [Find In Files] screen, select [Find In Files] from the [Edit] menu.  
The same screen can also be displayed by clicking the [Find In Files] button in Program Manager.  
 
The targets of searching from robot controller are only the robot programs.  
And the searching from robot controller takes time for a while, because of communicating with it.  
 

 
Fig. 5-50 Find In Files dialog 

 
[Never find Line No.] :  Checking this does not search line numbers from robot programs at all. 

 
When a search is started, a window displaying search results appears. The result is displayed as follows. 

 C: :/Program Files/MELSOFT/RT ToolBox E/1.prg(4): 40 MOV P1,-50 

File name Contents Line number from the top  
 

 

 
Fig. 5-51 Search result list display 

 
[Stop] :  Aborts the search. 
[Open with Program Edit] : Opens the program displayed on the line, which has been selected from the 

search result list, using the Program Edit tool.  
Any of the displayed programs can also be opened using the Program Edit 
tool by double-clicking the desired line. 

[Save a result] :  Saves the search result list in a file. 
 

Once the search is completed, the [Open with Program Edit] button and the [Save a result] button can be 
performed.  
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5.8.8. Replace 
The designated character string is replaced. The replacement range can also be designated. 
Select [Replace] under the [Edit] menu to display the Replace screen. 
 

 

 
Fig. 5-52 Replacement dialog 

 
 [Search Next] : Each time this button is clicked on, the next replacement target character string will be 

searched for. 
 [Replace Next] : Each time this button is clicked on, the next replacement target character string will be 

replaced. 
[Replace All Setting] : If this button is clicked, the items for designating the range are displayed in order to replace 

all of the designated character string. 
 
[Replace All Setting] can be used to replace the designated character string by designating the replacement 

range. 

 
Fig. 5-53 Replace All 

 
 

Cautions for replacement work 
- Do not change numeric values in PC support software prior to version C1. 

Do not change numeric values in PC support software prior to version C1. 
If numbers are replaced, the line Nos. will also be replaced, and the program contents will change. 
(For example, if 40 is replaced with 30, the same command as line No. 40 will be overwritten on line 

No. 30.) 
If numbers are inadvertently replaced, carry out [Undo] under the [Edit] menu before carrying out any

other operation. 

Caution 
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5.8.9. Jump 
The program jumps to the designated label, line No. (BASIC editing No.) or step position (line No. hide 

mode). To carry out jumping, select [Jump] under the [Edit] menu. 
 

Designate line No. or step position label. 

 
Fig. 5-54 Jump 

  
 
 

 

5.8.10.  Partial Transmission 
The selected program line is written into the robot controller. 
This is convenient to reflect the contents of modification in which only a portion of the program was modified 

in the robot controller. However, exercise caution since only the selected portion will be written.  
After selecting the line to be written into the robot controller, select [Partial Transmission] in the [Edit] menu. 

 
Fig. 5-55 Partical transmission 
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5.8.11. Automatic numbering (Only BASIC editing mode) 
This function automatically displays the next line No. each time the Enter key is pressed. The start line No. 

and line pitch can be designated with the setting dialog.  
 
The setting dialog will appear when [AUTO Number] is selected under the [Tool] menu.  

 
 

Input Start Line No.and Line pitch. 

When Enter is returned, the line
No. will appear automatically. 

 
Fig. 5-56 State of setting dialog and editing screen 
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5.8.12. Assigning line Nos. 
The line Nos. can be assigned in a batch within a designated range. The start/end line No. , new start line 

No. and line pitch can be designated with the setting dialog.  
 
Renumbering is possible by displaying the renumber setting dialog with [Renumber] under the [Tool] menu.  

 

Set range to renumber. 

Set start No. and pitch.

The line Nos. are assigned.

Click on OK to start renumbering. 

 
Fig. 5-57 State of setting dialog and renumbering operation results 
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5.8.13. Command template 
The MELFA BASIC IV language command list is displayed. When a command in the list is selected and the 

[Insert] button is clicked on, or when the command is double-clicked on, the command can be inserted into the 
program command editing screen. Displays per command type and searching of commands with character 
strings are possible. 

Display the command template screen by selecting [Command template] under the [Tool] menu. 
 

 Select type of command to display 

Command list 

Insert command into editing screen 

Search for command

 
Fig. 5-58 Image of command template 

 

 

 

 

5.8.14. Position variable template 
Position variables used frequently regardless of the program can be stocked. When a position variable in 

the list is selected and the [Insert] button is clicked on, or when the variable is double-clicked on, the position 
variable on the template can be additionally inserted into the program being edited.  

Display the position variable template screen by selecting [Position variable template] under the [Tool] 
menu. 

 

Selected position variable is inserted 
onto program editing screen.

List of orthogonal coordinate
type variables. 

List of joint coordinate type
variables. 

 
Fig. 5-59 Position variable template 

 

The position variables registered on the position variable template are saved even after the program editing 
tool is exit.  
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5.8.15. Position variable batch change 
The position variables in the program being edited can be changed as a batch, or the values can be added 

as a batch. For example, 100 can be added to the X elements of P1, P2, P3 and P4 as shown below.  
Display the batch change screen by selecting [Position variable batch edit] under the [Tool] menu. 
 
 

Select the compensation method 
from add or change. Select position variable to be compensated.

Register variable to be compensated. 

Delete variable to be compensated. 

Execute batch compensation. 

 
Fig. 5-60 Image of position variable template 

 

 

 

 

5.8.16.  Program conversion 
 

The Robot Programming supporter for E/EN/M1 and M2 series (hereafter "old PC support S/W") and the 
support softwares for the new personal computer (hereafter "new S/W") differ in the configuration of position 
data. Therefore, the program prepared by using the old PC support S/W cannot be used as it is in the new 
S/W. 

The program conversion converts the position data as well as the instructions (DJ, MP, and PD instructions 
of the Move Master command) related to the position data so that the robot programs created and saved by 
the old PC support S/W can be used with this new S/W. 

 
 

 



5. Program editing tool 
 

 Syntax check 5-69 

5.9. Syntax check 

This function checks whether the edited robot program is grammatically correct. Use this before writing the 
program into the controller. If there is any error in the grammar, the error section and the details of the error will 
be displayed. 

To use the grammar check, select [Grammar Check] under the [Tool] menu. 
 

Select and jump to error section in list

 
Fig. 5-61 Display of grammar check results 
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5.10. Debugging a program 

 
The program can be directly debugged while editing the program and moving the robot. It is also possible to 

confirm which line of the program is being executed while the robot is moving. Either step execution or direct 
execution can be used. 

 

5.10.1. Open the program 
To debug the program, select [Debug] under the [File] menu, and open the program. 
The editing screen for the program opened with will appear. 

 
 

Start from here. 

Debug editing screen appears.

 
Fig. 5-62 Debugging a program 
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5.10.2. Step execution 
The program opened with debug can be confirmed by moving one line at a time. 
The following dialog will appear when [Step Execution] is selected from the [Tool] menu.  

 

One line feed. 

Trace return. 

Continuous execution. 

Stop. 

Operation state display. 

Designate execution start line. 

 
Fig. 5-63 Step execution 

 
[Step feed] : The program is executed one step at a time. 
[Continuous execution] : The robot program is continuously executed. 
[Set] : Set the program execution start line No. 
 

 
When step execution is carried out, the robot may move at the max. speed, so take special care 

to safety. Never enter the work area when carrying out step execution. 

 

Caution 

 
 

The line currently being executed is highlighted on the editing screen. 
 

Executing line No. 40. 

 
Fig. 5-64 The line currently being executed 
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5.10.3. Direct execution 
The robot can be directly moved by inputting a command statement.  
The following dialog will appear when [Direct Execution] is selected from the [Tool] menu. 

 

Describe direct execution statement.

Direct command transmission history.

Transmit 

 
Fig. 5-65 Direct execution 

 

 
When direct execution is carried out, the robot may move at the max. speed, so take special care 

to safety. Never enter the work area when carrying out direct execution. 

 

Caution 
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5.11. Program Management  

 
The program files can be copied, moved, deleted, renamed, protected and the contents compared.  
The Program Manager can be used from the [Program Management] menu.  

 

 
Fig. 5-66 Program management 

 
The targets of any operations in this function are the Robot Program files. 

 

Caution 
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5.11.1. List 
The lists of the program files are displayed. For programs in the controller, the "Name", "Size", "Date", 

"Time", as well as the "Protect information", "No. of lines", "No. of position variables", "Latest cycle time", 
"Average cycle time", "Operation time", "No. of cycles" and "Comment“ are displayed.  

 
* As for the programs in the personal computer and in the controller, when even the contents are the same, the 

program sizes are different. 
 

Execute buttons 

Release the selection 

Refresh both of the lists[File In Files] screen will appear.

 
Fig. 5-67 Program list 

 
Double-click on a program name in the lists, Program Edit Tool is started up and that program can be edited. 
But only programs in the robot controller or “ *.prg ” files in the personal computer can be edited. Note that 

the another files are Opened, then Program Edit Tool cannot behave regularly. 
According to the operation, the multiple files can be operated. Selecting the multiple files, click on the files in 

the lists by the mouse with pressing the [shift] key or the [Ctrl] key. Releasing the selected files in the lists, click 
on the [Selection Release] button above each lists. 

Version E1 or later of this software supports the display of available capacity. 
 
Click on the [Browse] button and select folder at the [Browse for Folder] dialog, and the folder in the 

personal computer can be selected. 

 
Fig. 5-68 Browse for Folder dialog screen 
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5.11.2. Copy 
The program files are copied. Copying of the entire program file or only the command statements or only the 

position variables is possible.  
Select the transmission source program names from the list at the left, and designate the transmission 

destination folder on the right side. The multiple transmission source programs can be selected at the same 
time, but for copying with changing its name, only one program must be selected. Copying is executed when 
the [Copy] button is clicked on and [Setup for COPY] dialog is set. 

 
Fig. 5-69 Setup for COPY dialog screen 

 
 
 

5.11.3. Movement 
The program files can be moved.  
Select the transmission source program names from the list at the left, and designate the transmission 

destination folder on the right side. The multiple programs can be selected at the same time. Movement is 
executed when the [Move] button is clicked on. 
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5.11.4. Delete 
The program files can be deleted. Note that once the program files are deleted, they cannot be recovered.  
Select the names of the programs to be deleted from the lists. The multiple programs can be selected at the 

same time. The programs can be selected at the both lists. Delete is executed when the [Delete] button is 
clicked on. 

 
 
 

5.11.5. Rename 
A program file name is renamed. 
Select the name of the only one program to be renamed from the lists. The program can be selected at the 

both lists. Rename is executed when the [Rename] button is clicked on and a new file name is set at the 
[Setup for RENAME] dialog. 

 
Fig. 5-70 Setup for RENAME dialog screen 
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5.11.6. Protect 
The program files in the controller can be protected. The entire program file can be protected, or just the 

command statements or position variables can be protected. 
Select the names of the programs to be protected from the lists. The multiple programs can be selected at 

the same time. The programs can be selected at the both lists. Protect is executed when the [Protect] button is 
clicked on and [Setup for PROTECT] dialog is set. 

 
Fig. 5-71 Setup for PROTECT dialog screen 
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5.11.7. Comparison 
The program files can be compared. Comparison of only the command statements or only the position 

variables is possible. Select the names of the programs to be compared from the left and right lists. A dialog 
displaying the corresponding comparison results will appear when the [Compare] button is clicked on and 
[Setup for COMPARE] dialog is set.  

 

 
Fig. 5-72 Setup for COMPARE dialog screen 

 
When both files are the same, the result dialog display nothing.  
 

 
Fig. 5-73 Display of comparison results 
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6. Monitoring tools 
With the monitoring tools, all of the information in the currently connected robot controller can be constantly 

displayed.  
 

6.1. Starting 

Select the "Monitoring tool" from the "RT ToolBox  Robot Total Engineering Support Software" menu. The 
"Monitor menu" shown below will appear. 

After selecting the robot you wan to monitor, click an item with the mouse. The monitor window for each 
robot appears. (Robot selection is supported in D1 version or later.) 

The selected robot controller is displayed in each monitor window title. 
  

 
Fig. 6-1 Monitor menu 

 

   The controller selected in [Robot Controller] 
for the communication server is displayed 
as the initial value (Version D3 or later). 
(The No. 1 robot controller is displayed in 
Versions D1 and D2.) 

 
Fig. 6-2 The controller selected for the communication server 

 

 
Constant communication is established with the robot controller while each monitoring tool is 

started. Close any unnecessary windows to reduce the communication load. 

 

Caution 
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6.2. Outline of each function and starting methods 

 
(1) Outline of each function 

Each monitor function is explained briefly in this section. The monitor functions are largely classified into the 
following three groups. 

1. Robot movement monitor ..........  Items related to robot movement are monitored. 
2. Operation monitor ....................... Items related to the robot's operation are monitored. 
3. Servo monitor ............................. The robot's servo system information is monitored. 

 

 Monitor name Explanation 
Slot run state The operation state of each slot can be confirmed. 
Stop signal The stop signal input into the robot controller can be confirmed. 
Error The currently occurring error can be confirmed. 

The history of the errors that have occurred can be confirmed. 
Program monitor The program execution line set for each slot, the contents of the 

variable used in the program, and the robot current position, etc., can 
be confirmed. 

General-purpose input 
signal 

The state of the signal input from an external device to the robot 
controller can be confirmed. 

General-purpose output 
signal 

The state of a signal output from the robot controller to an external 
device can be confirmed. The signal can also be output forcibly. 

Named signal The status can be checked by naming the status of the dedicated I/O 
signal that has been set in the robot controller, as well as each bit or 
within the range of 32 bits of the general-purpose signal.  
The signals are set via parameter setting (maintenance tool). 

Movement State The current position information and hand open/close state  
of each connected mechanism can be confirmed. 

Input register The input registers in the CC-Link function can be monitored and 
pseudo-input. 

R
obot m

ovem
ent m

onitor 

Output register The output registers in the CC-Link function can be monitored and 
forcibly output. 

Operating time  The robot operation time (power ON, etc.) can be confirmed. 
Production information The operating time of the program in the robot controller and the No. of 

program cycles can be confirmed. 
Robot version The robot controller version can be confirmed. 

O
peration 
m

onitor Option card information Information on the option card mounted on the robot controller  
can be referred to. 

S
ervo 

m
onitor 

Servo monitor position, 
speed, current, load, 
power 

The servo system information can be monitored. 

 

(2) Operation method 
Mouse operation : Click on the button for the item to be displayed from the Monitor menu. 
Keyboard operation : While holding down the [Alt] key, press the alphanumeric character displayed at the 

left of the button. 
(Example: Press the [4] key while holding down the [Alt] key to display the program monitor. Hereinafter, expressed 
as [Alt] + [4].) 
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6.3. Exit the monitor menu 

  
Click on the "Exit (X)" button on the screen to quit the monitor menu. 
Press [Alt] + [X] to exit using the keyboard. 
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6.4. Each monitor function 

 
Each monitor function is explained in this section. 

 

6.4.1. Robot movement monitor 
 

6.4.1.1. Slot Run State 
The state of the slots in the robot controller can be monitored. 
The No. of displayed slots is determined with the parameters. 

 

This window size can be changed.
Press the right mouse button at this 
position to change the size. 

 
Fig. 6-3 Slot Run State 

 

 

6.4.1.2. Stop Signals 
The state of the stop signal (stop, emergency stop) input into the robot controller can be referred to. 

 
Fig. 6-4 Stop Signals 
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6.4.1.3. Error 
The errors currently occurring in the robot controller are displayed.  

 

(1) Currently occurring errors 
 

The "Error history" window 
is displayed. The "Error history" can be 

confirmed for each error level.

Detailed information (cause and 
recovery) of the occurring error can 
be confirmed. 

The history of the errors that 
have occurred in the past can 
be referred to. 

 
Fig. 6-5 Currently occurring errors and Error Detailes 
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(2) Error history 
The history of errors that have occurred in the past can be referred to.  
This display is not shown at all times. To update the information, press the "Update" button.  

 
 

The displayed 
information is 
updated. 

The cause and 
remedy of each error 
can be confirmed. 

The displayed error 
history information is 
saved in a file. 

The error history 
information is 
cleared. 

 
Fig. 6-6 Error history 
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6.4.1.4. Program monitor 
Information of the running program can be monitored.  

 
(1) Program monitor 

 
Fig. 6-7 Program monitor 

[Variable] : The value of the variables in the running program can be referred to. 
The variable to be displayed can be selected. 

 
[Watch]  : The constant display window for the variables used in the running program is displayed. 
 
[Option] : The No. of execution lines of the program being executed can be changed. 

 
As the program monitor uses a large amount of information, when monitoring the variables with "Watch", 

the update of the display data may be delayed from the actual information.  
When only the variables are to be monitored, press the monitor [Start] and [Stop] buttons on this screen, 

stop the display program monitor, and then watch.  
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(2) Current/target position monitor 
The current/target position monitor can monitor the current robot position and the target robot position 

while the robot is operating. The position information is displayed in the orthogonal coordinate system and 
joint coordinate system.  

 
Fig. 6-8 Current/target position monitor 

 
To display this screen, press the button under the toolbar, or select [Monitor] and then [Open 

Current/Target Position Screen] from the menu.  
 

    

 
Fig. 6-9 Open Current & Target Pos. 
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(3) Watch monitor  
With the watch monitor, the variables to be constantly displayed can be selected.  
When the [Watch] button is clicked on, the watch monitor window and a window for selecting the 

variables to be displayed will appear.  

 
Fig. 6-10 Watch monitor 

  
 

[Selection change] The watched variable can be selected from the variable list used by the program. 
When [Selection change] button is clicked, the screen like the right is displayed. [Add] button is 
clicked after the variable watched on this screen is selected, and the variable monitored to 
[Displayed Variables] is selected. If the watched variable is selected, [OK] button is clicked.  
The variable which is not displayed here can be specified by the [Add Value]. 

 
Fig. 6-11 Select variable to Watch 
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[Add Variable]  The variables to be monitored can be designated. 
Input the variable in Variable Name, select the variable type, and then click on the [OK] 
button. 

 
Fig. 6-12 Add 

 
[Change] The value of the variable being watched now is changed. Variable identifier to which the value is 

changed is clicked double or [Change] button is clicked while selected. Variable value change 
window is displayed.  

 
notes)  Please note that the movement of the robot might change by the change enough when you change 

the value. 
 

When the variable name is selected and the [Value Change] button is clicked on, the window for making 
changes will appear.  

 

 (Location) (Integer, Float, String)  
Fig. 6-13 Variable change 
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Please click [Change] button after changing the value. However, Please note that the movement of the 
robot might change by the change enough when you change the value.  

 
Fig. 6-14 Warning 

 
 
 
[Load]/[Save] The list of the variable monitored by Watch is preserved in the file or the monitored variable 

can be read from the file. (This function corresponds from Ver.C1.) 
  

Variable name, the type, and the value being watched now can be saved in the file by 
clicking [Save] button. 
 
Variable name and the variable type are read from the saved file when [Load] button is 
clicked, and it is possible to add [Watch] as a monitored variable. 

 
 
 
About the hexadecimal number display   
 

The variable displayed with "Varialble List" and "Watch" can be switched to the hexadecimal number/the 
decimal number. 

Please select the type which wants to be displayed with "View" on each screen. 

 
Please refer to the following for the variable which can be displayed by the hexadecimal number. 

Integer The displayed variable can be switched to the hexadecimal 
number/the decimal number. 

Float 
When it is 0 below the decimal point, it is possible to switch to the 
hexadecimal number/the decimal number. 
However, the value is the one within the range of -9999999-9999999. 

String The hexadecimal number is not displayed. 
Location The hexadecimal number is not displayed. 

As for the value displayed by the hexadecimal number,  &H is added to the head of the value. 
(This function corresponds from Ver.C1.) 
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6.4.1.5. General-purpose input signals 
  

The status of the signals input into the robot controller can be monitored. 

 
Fig. 6-15 General purpose INPUT Signals 

 
When the [Pseudo-input] button is clicked on, the robot controller will enter the "pseudo-input mode", and 

the following window will appear. 
 

 To cancel the pseudo-input mode, the robot controller power must be turned ON again. 
Caution 

 

General-purpose monitor 
With the general-purpose monitor, monitoring can be carried out by designating the head signal No. and 

number of signals to display.  
 

 
 Start/stop the general-purpose 

monitor. 
The head signal No. and number of 
signals to display can be changed 
only while the monitoring is stopped.

Change the head 
signal No. and the 
number of signals to 
display to be 
monitored. 

The size of this 
window can be 
changed. 

 
Fig. 6-16 Custom monitor(INPUT) 
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pseudo-input  
 

The current state is read out 
with the designated signal No. 
as the head. 

The pseudo-input state 
is set as a port unit. 

All input states are turned ON. All input states are turned OFF.

The designated signal 
information (16 signals) 
is set.

 
Fig. 6-17 Pseudo-input 

 

 
In the pseudo-input mode, the state input from the following window is interpreted as the input signal 

instead of the robot controller general-purpose input signals. 
 

1. First the signal to be pseudo-input signal is read. 
16 signals can be set simultaneously. Input the head No. of the signal to be read, and then click on the 
"Select" button. 

2. The input state of the 16 signals is displayed with the designated signal at the head. Set the 
pseudo-input state, and then click on the "Pseudo-input setting" button. 

3. 16 signals from the No. designated as the head can be forcibly output as a hexadecimal. 
Input the hexadecimal value, and then click on the "Port pseudo-input" button. 
 
The pseudo-input mode is canceled when this button is closed.  
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6.4.1.6. General-purpose output signal 
 

The state of the signals output from the robot controller can be confirmed. 

 
Fig. 6-18 General-purpose output signals 

 
 

General-purpose monitor 
With the general-purpose monitor, monitoring can be carried out by designating the head signal No. and 

number of signals to display.  
 

 Start/stop the general-purpose monitor. 
The head signal No. and number of signals to 
display can be changed only while the monitoring 
is stopped.

Change the head 
signal No. and 
the number of 
signals to display 
to be monitored. The size of this 

window can be 
changed. 

 
Fig. 6-19 Custom monitor(OUTPUT) 
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Forced output 
The robot controller's general-purpose signals can be forcibly output.  
Click on the "Forced output" button. A window for forcibly outputting the signal will appear.  

1. First, read out the signal to be forcibly output. 
16 signals can be output simultaneously. Input the head No. of the signal to be read, and then click 
on the "Read" button. 

 

The designated signal information (16 signals) is output. The signal is forcibly output as a port unit.

The current state is read out with the 
designated signal No. as the head. 

 
Fig. 6-20 Forced output 

 
2. The output state of the 16 signals is displayed with the designated signal at the head. Set the 

output state, and then click on the "Forced output" button. 
3. 16 signals from the No. designated as the head can be forcibly output as a hexadecimal. 

Input the hexadecimal value, and then click on the "Port output" button. 
 

 

・The signal Nos. assigned (used) with the dedicated output signal cannot be forcibly output. 
・Forced output is possible in the [TEACH], [AUTO (OP)] and [AUTO (EXT.)] states, but if even one

program is running, output is not possible. (Excluding the ALWAYS program.) 

Caution 
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6.4.1.7. Named signal 
The status can be checked by naming the status of the dedicated I/O signal that has been set in the robot 

controller, as well as each bit or within the range of 32 bits of the general-purpose signal. The signal file in 
the robot controller is loaded at startup. If, however, it is not found, the previously used file is loaded.  

The signals are set via parameter setting (maintenance tool).  
 

The dedicated signals can neither be edited 
not deleted. Use the maintenance tool to set 
these signals. 

 
Fig. 6-21 Named Signals 

 
[Edit]/[Delete] 

The I/O signals you want to monitor can be added or edited. Enter 
the range of the signals you want to monitor in the Start No. and End 
No. boxes, and name it. If the signal you want to monitor is one bit, 
enter only the start No. For multiple bits, enter the numbers so that the 
start No. is smaller than the end No. (If reversed, an error will occur.) 
Binary, decimal or hexadecimal notation can be selected as the 
display method. For decimal notation, signed display using the most 
significant bit as a signed bit can also be performed. 

Once the entry is finished, click the [Add]/[Change] button. If the 
[Add] button is clicked when a signal name is being selected, it is 
inserted to the selected line. If a signal name is not being selected, it is 
added at the end of the list. 

You can delete unwanted signal names from the list by selecting 
them and clicking the [Delete] button. 

 
[Load]/[Save] 

The edited result can be saved on or loaded to a personal computer or robot controller. Specify the save 
destination/load destination and click the [OK] button. If the save destination is a personal computer, a file 
name can be specified. However, if the save destination is a robot controller, the result will be overwritten 
on the previous information.  

 

Fig. 6-22 Edit of Signal Name 
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6.4.1.8. Movement State 
 

With the operation confirmation, the robot's movement range, current position and hand open/close state, 
etc., can be confirmed.  

 
* "Robot Monitor" robot 3D monitor function in the "Movement State" is compatible only with the standard 

version (STD). 
 

 

The viewpoint can be changed by rotating the
designated coordinate axis. 
The viewpoint can also be changed by the
following mouse operations: 
 
* Dragging left button 

left and right Æ Rotation of Z-axis center 
up and down Æ Rotation of X-axis center 

* Dragging left + right button 
left and right Æ Rotation of Y-axis center 

* Dragging right button 
up, down, left and right Æ Move 

* Dragging left button + [Shift] key 
up and down Æ Enlargement/reduction 

The size of the robot display
can be changed. 
It can also be changed with
dragging left mouse button +
[Shift] key to up and down. 

When this button is clicked on,
the operation of the  
currently connected robot can
be confirmed with graphics. 
With this function, the robot
operation can be confirmed
from a remote place using
remote maintenance. 
Note that when this robot is
being displayed with graphics,
monitoring of the section
enclosed in the dotted line will
stop. 

The size of this 
window can be 
changed. 

 
Fig. 6-23 Movement State 
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6.4.1.9. Input register 
 

This screen cannot be referred to if the CC-Link option card is not mounted on the 
robot controller. 

 
The values of the CC-Link function input registers can be monitored. 

 

The size of this window 
can be changed. 

Monitoring of the registers shown on the left 
can be started and stopped.

The register to be monitored can be changed. 
(For example, monitoring of only No. 6000 is 
possible.) 
When monitoring is stopped, this button will 
become valid. 

The input registers are pseudo-input. 

 
Fig. 6-24 Input register 

Monitor setting 
When “Stop” is selected for the monitor state, the “Monitor Setting” button will be a validated. 

  

The No. selected in the “information List” will move to the 
“Display List”. 

The Number selected here will be the register
to monitor. 

All Numbers in the Information List” will move to the 
“Display List”. 

The Number selected in the “Display List” will move to the
“Information List”. 

All Numbers selected in the “Display List” will move to the
Information List”. 

 
Fig. 6-25 Monitor setting 

 

When a large amount of information is monitored, the communication size with the robot 
controller will increase, and it may take time to update the information. It is recommended to 
monitor only the required registers with the monitor setting.

Caution 
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Pseudo-input 
With the pseudo-input mode, the values input from the following window will be interpreted as the input 

register values instead of the registers input from an external source. 
 

Refer to the pseudo-input of the 
 general-purpose input signals. 

The input registers are 
 pseudo-input. 

 
Fig. 6-26 Pseudo-input (Signals & Register) 

 
 

 
<Operation methods> 

1) First, read out the registers to be pseudo-input. Up to 16 sequential registers can be set simultaneously. 
Input the head No. of the register to be read and the number of registers to read, and then click on the 
"Select" button. 

2) The values of the designated number of registers will appear with the designated register at the head. 
3) Set the register value, and click on the "Register Pseudo-Input" button. 

 
The pseudo-input mode is canceled when this window is closed. 
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6.4.1.10. Output register 
 

This screen cannot be referred to if the CC-Link option card is not mounted on the 
robot controller. 

 
The values of the CC-Link function input registers can be monitored. 

 

The size of this window
can be changed. 

Monitoring of the registers shown on the left can be 
started and stopped. 

The register to be monitored can be changed. (For
example, monitoring of only No. 6000 is possible.) 
When monitoring is stopped, this button will
become valid. 

The output registers are forcibly output. 

 
Fig. 6-27 OUTPUT Register 

 
Monitor setting 

When “Stop” is selected for the monitor state, the “Monitor Setting” button will be a validated. 
 

The No. selected in the “information List” will move to the 
“Display List”. 

The Number selected here will be the register to
monitor. 

All Numbers in the Information List” will move to the 
“Display List”. 

The Number selected in the “Display List” will move to the 
“Information List”. 

All Numbers selected in the “Display List” will move to the 
Information List”. 

 
Fig. 6-28 Monitor setting 

 
 

When a large amount of information is monitored, the communication size with the robot 
controller will increase, and it may take time to update the information. It is recommended to 
monitor only the required registers with the monitor setting.

Caution 
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Forced output 
The registers can be forcibly output. 

 
Fig. 6-29 Forced output(Register) 

 
<Operation methods> 

1) First, read out the registers to be forcibly output. Up to 16 sequential register can be output 
simultaneously. 
Input the head No. of the register to be read and the number of registers to read, and then click on the 
"Read" button. 

2) The designated number of registers will appear with the designated register at the head. Set the value, 
and click on the "Forced Output" button. 
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6.4.2. Operation monitor 
 

6.4.2.1. Operating time accumulation 
 

  The robot operating time, and battery usage time, etc., can be confirmed. 

  

The connected robot and it's servo ON 
time can be confirmed. 

Each operating time is cleared. 

 
 

Fig. 6-30 Operating time accumulation 
 
 

6.4.2.2. Production information 
 

The latest cycle, operation time, No. of cycles and average cycle time for each program in the robot 
controller can be confirmed. 

The production information is not constantly displayed. Click on the "Update" time as necessary. 

 
Fig. 6-31 Production information 
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6.4.2.3. Robot version 
 

The robot controller version can be confirmed. 

 
Fig. 6-32 Robot version 

 
 
 

6.4.2.4. Additional Board Information 
 

Information on the option card mounted on the robot controller can be confirmed. 
Note that this screen cannot be referred to if robot controller is not provided with a slot for mounting the 

option card. 

 
Fig. 6-33 Additional board information 
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6.4.3. Servo monitor 
 

The servo system is monitored. 
 

6.4.3.1. Position ( ABS ) 
The state of the currently connected robot encoder can be monitored. 

 
Fig. 6-34 Servo monitor --- Position(ABS) --- 

 
 

6.4.3.2. Speed 
The motor speed, etc., of each robot axis can be monitored. 

 
Fig. 6-35 Servo monitor --- Speed --- 
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6.4.3.3. Current 
The current state of each robot axis can be monitored. 

 
Fig. 6-36 Servo monitor --- Current --- 

 
 
 

6.4.3.4. Load 
The load state of each robot axis can be monitored. 

 
Fig. 6-37 Servo monitor --- Load --- 
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6.4.3.5. Power 
The power state of the robot's main circuit can be monitored. 

 
Fig. 6-38 Servo monitor --- Power --- 
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7. Parameter editing tool 
The parameter edit tool can be used to reference and rewrite the parameter information set in the robot 

controller. 
 

7.1. Starting of Parameter editing tool 

Select [Parameters] from the menu. [Edit Parameters] shown below appears.  
At this point, a connection will be automatically made to the robot controller set on the communication 

server.  

 
 

Fig. 7-1 Parameter editing tool (E1 or later) 
 

The parameter edit screen differs depending on the number of machines being connected and the version of 
this software. If multiple machines are being connected or Version D2 or earlier is in use, the parameters are 
displayed for each machine as shown in the figure below 

 
 

 
Fig. 7-2 

 
If the power to the robot controller specified on the communication server is not on or it is not connected 

correctly when starting the parameter edit tool, the "Select Read Destination" screen appears. In this case or 
to change the parameters of the robot controllers other than the robot controller specified on the 
communication server, see Section  "7.2 Selecting the Read Destination" 
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7.2. Selecting the Read Destination 

The Select Read Destination screen can be displayed by one of the following operations: 
1. Choose [Select Read Destination] from the [File] menu. 

2. Click  from the tool chip.  
3. When unable to communicate with the robot controller specified on the communication server 
(power not on, not connected correctly, etc.) 

 
Fig. 7-3 Select target 

 
To connect with a robot controller and perform the maintenance of the parameters in the robot controller, 

select [Robot Controller]. To edit the parameter information that has been downloaded to a personal computer, 
select [File]. If a robot controller has been selected as the load destination, select the robot controller you want 
to connect. 

 
   The controller selected in [Robot Controller] 

for the communication server is displayed 
as the initial value (Version D3 or later). 
(The No. 1 robot controller is displayed in 
Versions D1 and D2.) 

 
Fig. 7-4 The controller selected for the communication server 

 
 
 
 

7.2.1. Selecting a robot controller 
If you have selected a robot controller as the read destination, select the robot controller you are connecting, 

and then click the [Select] button. 

 
Fig. 7-5 Selecting a robot controller 

 
The parameter edit screen for the robot controller you have selected appears.  
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7.2.2. Selecting files 
The information that can be edited here includes batch backed-up data or backed-up parameters. If [File] is 

selected, the window for selecting the parameter information you will be editing appears. 

 
Fig. 7-6 Selecting files 

 
Here, double-click the folder containing the parameter information. You can now edit the parameter 

information in the folder you selected. 
 

 
Fig. 7-7 The parameter information in the selected folder 
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7.3. Downloading the parameter list (Controller -> PC) 

 

 
Fig. 7-8 Confirmation 

 
This window will appear in the following cases. 
1. When there is no parameter list information in the personal computer. 
2. When the parameter list used in the robot controller is newer than the parameter list already stored in the 

personal computer. 
 

* Although it will take approx. five minutes to download the parameter list information, using the latest 
parameter information is recommended. 

 
【Reference Values】 When Version J1 of the robot controller software and Version E1 of this software are 

connected 
When using RS-232C (9600 baud rate) : 4 min. 30 sec. 
When using RS-232C (19200 baud rate) : 2 min. 30 sec.  
When using Ethernet : 24 sec. 

 
If the parameter list information is not read out correctly, the following type of window will appear. 

 
 

Refer to the robot instruction 
manual for details on the 
parameters displayed here. 

 
Fig. 7-9 Parameter List 

The parameter list can be read from the robot controller or from the personal computer using these buttons. 
 

Reading the parameter list 
[From R/C] : The parameter list is read from the robot controller. 
[From File] : The parameter list written in the personal computer is read. 
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7.4. Changing the parameters 

 
Click on a parameter displayed in the list, or input the parameter name, and then click on the "Change" 

button. 
The designated parameter information in the robot controller or personal computer will appear. 
After confirming the parameter, the parameter information in the robot controller can be rewritten by clicking 

on the "Write" button. (When editing the parameter information saved in the personal computer, the "Write" 
button will change to an "OK" button.) 

 
Fig. 7-10 Changing the parameters 

 

 
There are some parameters that cannot be edited. In this case, the "Write" button operation will be disabled. 
 

 

Use upper case letters when naming the programs  
in alphabetic characters.  

Lower case alphabetic characters can be used in this parameter setting. 
Use upper case letters when naming the programs in alphabetic characters for the parameters of the 

base program (PRGUSR) or slot table (SLT*), etc. All of the program names within the robot controller 
will be expressed in upper case letters. 

If lower case letters are used, the programs will not be properly recognized. 

Caution 

 
 

To validate the rewritten parameter information in the robot controller, the robot controller power 
must be turned ON again. 

Caution 
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 Operating Modes of the Robot Controller When Writing Parameters 
Software version 
of robot controller Writable mode switch 

Version J1 or 
later 

Parameters can be written in any of Teach, Auto(OP) and Auto(Ext) modes. 
However, parameters cannot be written while any program with other than the 
startup condition of ALWAYS has been started. In such a case, stop the program, 
and then write parameters. 

H7 or earlier Parameters can be written only in Teach mode.  
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7.6. Parameter menu 

 
With this tool, parameter panels grouped as windows for each function are prepared. Select the name of the 

parameter to be referred to with "Parameter setting" on the menu. 

 
Fig. 7-11 Paramter menu 

 

 

The language (MELFA-BASIC IV/MOVEMASTER command) to be used by the controller can be 
changed with the "Robot Language" parameter. Note that the robot models that can use the 
MOVEMASTER commands are limited. Refer to the Standard Specifications for the model in use to 
confirm whether the commands can be used. 

Caution 
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7.6.1. Motion Limit Parameter 
Set the operating range of the robot 

. 

 
Fig. 7-12 Motion Limit parameter 

 

7.6.2. JOG Parameter 
Set the speeds of joint jog and orthogonal jog. 
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Fig. 7-13 JOG parameter 
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7.6.3. Hand Parameter 
Set the type of the hand (single solenoid/double solenoid, etc.) and work holding/non-holding when 

HOPEN* (open hand) and HCLOSE* (close hand) are executed. 

 
Fig. 7-14 Hand parameter 

 

7.6.4. Workpiece and Hand Weight 
Set the hand conditions and work conditions. 

 
Fig. 7-15 Workpiece and Hand weight 

 
WRKDAT0 and HNDDAT0 might not be able to set according to the kind of the connected robot. In that case, 

the row of WRKDAT0 and HNDDAT0 cannot be input. 
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7.6.5. Tool 
Set the standard tool coordinates and standard base coordinates 
 
This screen is different according to the software version of the controller who connects it. 

 
(1) Robot controller Ver. H7 or earlier 

 
Fig. 7-16 Tool (Robot controller Ver. H7 or earlier) 

 
 

(2) Robot controller Ver. J1 or later, and Robot which cannot use “Position repair tool” 

 
Fig. 7-17 tool ( Robot controller Ver. J1 or later 1) 
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(3) Robot controller Ver. J1 or later, and Robot which can use “Position repair tool” 

 
Fig. 7-18 tool ( Robot controller Ver. J1 or later 2) 

 
 

Please refer to “12. Position repair” for the robot which can use "Position repair tool". 
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7.6.6. Slot Table 
Set the operating conditions of each task slot during multi-task operation. 

 
Fig. 7-19 Slot Table 

 
Select the task slot number you are changing 
and click the [Modify] button. When the 
modification window appears, set the program 
name, operating conditions, startup conditions 
and task priority, and then click [Write]. 

Fig. 7-20 Slot Table – Change 
 

When the [Revert to Initial Values] button is clicked, the 
following confirmation screen appears 

Fig. 7-21 Initialization confirmation 
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7.6.7. OUTPUT Signals Reset pattern 
Set the operation when resetting the general-purpose output signals such as the CLR instruction and 

dedicated input (OUTRESET). 

 
Fig. 7-22 OUTPUT Signals reset pattern 

 
Set a signal number, and then select one of [OFF]/[ON]/[Hold]. 

The value of the signal having the specified number displayed in the 
list changes. 

Also, selecting a signal group (for example, "32-0") and then 
clicking the [Select] button changes 32 signals at once. 

 
 
 
 
After confirming the signal number and settings of each signal, 

click the [Write] button 

Fig. 7-23 Change 
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7.6.8. Special-purpose I/O Signals assignment 
Assign signal numbers to functions in order to perform the remote operations to execute and stop robot 

programs, and display/operate the execution progress information and servo power supply status, etc.  
 
(1) General 

 
Fig. 7-24 General 

 
(2) Start(each Slot) 

 
Fig. 7-25 Start(each Slot) 



7. Parameter editing tool 

7-120 Parameter menu 

(3) Stop(each Slot) 

 
Fig. 7-26 Stop (each Slot) 

 
 
(4) Servo OFF(each Robot) 

 
Fig. 7-27 Servo OFF (each Robot) 
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(5) Servo ON (each Robot) 

 
Fig. 7-28 Servo ON (each Robot) 

 
 
(6) Machine Lock (each Robot) 

 
Fig. 7-29 Machine Lock (each Robot) 
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(7) Data 

 
Fig. 7-30 Data 

 
 
(8) JOG 

 
Fig. 7-31 JOG 

 
JOGNER(JOG command INPUT signal, During JOG OUTPUT signal) can be used with Version J2 or later of 

the robot controller software. 
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(9) HAND 

 
Fig. 7-32 HAND 

 
(10) Warm up mode 

This function can be used with Version F1 or later of this software. 
However, note Version J8 or later of the robot controller software. 
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7.6.9. Communication Parameter 
Set up the communication  

environment of the RS-232C interface located at the front of the robot controller. 

 
Fig. 7-33 Communiaction Parameter (RS-232C) 

 
 

7.6.10. Zone 
Specify the area (rectangular) defined by two orthogonal coordinate points. 

 
Fig. 7-34 Zone 
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7.6.11. Free Plane Limit 
Set the overrun limit used on free planes. 

 
Fig. 7-35 Free Plane Limit 

 
 

7.6.12. Home position 
Set the position of the escape point. 

 
Fig. 7-36 Home position 
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7.6.13. Program Language 
Set the position of the escape point. 

 
Fig. 7-37 Program Language 

 
 

The language (MELFA-BASIC IV/MOVEMASTER command) to be used by the controller can be 
changed with the "Robot Language" parameter. Note that the robot models that can use the 
MOVEMASTER commands are limited. Refer to the Standard Specifications for the model in use to 
confirm whether the commands can be used. 

Caution 
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7.7. Search 

 
Strings can be searched from the parameter list being displayed. This function is supported from Version E1 of 

this software. 
Select [Search String] from the [Search] menu. 
 

 
 

Fig. 7-38 Serach menu 
 
 

 
 

Fig. 7-39 Search window 
 

 
Enter the string you want to search in the search string field, and click [Search Next]. The specified string is 
searched from the current cursor position in the parameter list to the direction specified in [Search Direction]. 

 

 
 

Fig. 7-40 Result 
 

 



7. Parameter editing tool 

7-128 Initialization 

7.8. Initialization 

 

7.8.1. Initializing the battery remaining time 
The robot controller battery's remaining time can be initialized. This function is used when replacing the 

battery. 
Select "Initialize" - "Battery remaining time" from the menu. 
 

 
 

 

 

 
Fig. 7-41 Initializing the battery remaining time 

 

 

 

 

If the battery remaining time is initialized when not replacing the battery, the correct remaining 
time will not be displayed. 

Caution 
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7.9. System information 

 
The system information can be used to save the robot origin data into a file and to transfer the information in 

the file to the robot controller. 
Two types of origin data handling are described in this section, however, the file save format is different in 

each type. To write the saved information to the robot controller, use the same file save format. 
 

 

7.9.1. Robot origin data 
 

 

Controller modes available during the origin data read/write 
The controller modes (TEACH/AUTO (Op.)/AUTO (Ext.)) available for the origin data read/write 

are different depending on the controller and the version of this software. See the table on the 
following page for further details. 

Caution 

 
 

Select "System" - "Robot origin data" from the menu. 

 

 

  
Fig. 7-42 Robot Origin Data 

 
 

 [Save to file] : Can save the displayed origin data in a file. 
 [Read from file] : Reads the origin data saved in a file, and displays it on the screen. 
 [Edit] : Can edit the origin data that is being displayed on the screen. 
 [Write] : Writes the origin data that is being displayed on the screen into the robot controller. 
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DJNT (origin position error) parameters 
DJNT represents the origin position error. If the origin position is corrected using the Position Repair

Support Tool, a value will be given to this DJNT. (If the Position Repair Support Tool is not used to
correct the origin position, all elements will be set to 0. Note, however, that RV-4A will be given a default 
value.) 
Since DJNT is not available to the general user, values cannot be changed directly by the users. 
 
 

DJNT parameter display 
The DJNT parameters are displayed with version E1 or later of this software.  
Note, however, that they may not be displayed depending on the connected robot (such as the robots

that are not compatible with the position repair support function). 

Memo 

 
 
 

* Operating Modes of the Robot Controller When Writing Robot Origin Data 
When writing the origin data of the robot using this software, the restrictions on the operating modes of

the robot controller as listed in the tables below apply, depending on the version of this software and the 
version of the robot controller software. Refer to the table below. 

 
(1) When reading 

Robot controller  
Ver. J1 or later Ver. G9 to Ver. H7 Ver. G8 or earlier 

Ver. E1 or 
later 

Ver. C2 to 
Ver. D2 

Th
is

 s
of

tw
ar

e 

Ver. C1 or 
earlier 

Can read in all modes: 
Auto(OP) mode 
Auto(Ext) mode 
Teach mode 

Can read only in Auto(Ext) mode 
(Cannot read in any other modes) 

 
(2) When writing 

Robot controller  
Ver. J1 or later Ver. G9 to Ver. H7 Ver. G8 or earlier 

Ver. E1 or 
later 

Auto(OP) mode 
Auto(Ext) mode 
Teach mode 

Ver. C2 to 
Ver. D2 

Auto(Ext) mode 
Teach mode 

Auto(Ext) mode 
Teach mode 

Teach mode 

Th
is

 s
of

tw
ar

e 

Ver. C1 or 
earlier Origin data cannot be written by this software. 

 
 



7. Parameter editing tool 

System information 7-131   

7.9.2. Robot Origin Parameter <Backup> 
[Robot Origin Parameter <Backup>] can be used to back up the parameters that comprise the robot origin 

data. If the robot origin data has additional axes, use this function to back up the origin data. 

 

 

 
Fig. 7-43 Robot Origin Parameter 

 
 

 
 [Save to file] : Can save the contents of the parameters for the origin (displayed parameters) loaded from the 

robot controller in a file. 
 [Load to R/C] : Can transfer the parameters for the origin saved in a file to the robot controller. To transfer the 

parameters for the origin to the robot controller, set the mode to the [TEACH] mode. 
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7.10. Power Reset of the Robot Controller (Version E1 or later) 

To make modified parameters effective, it is necessary to power on the robot controller again.  The power 
reset of the robot controller can be performed from the personal computer in Version E1 or later of this 
software. 

However, note that this function can be used with Version J1 or later of the robot controller software. 
  

(1)  When Setting Parameters 
After setting parameters, the power reset confirmation screen appears. To immediately reset the power, 

select [Yes]. To set more parameters, set all the necessary parameters first, and then select [Yes].   
 

 
Fig. 7-44 Confirmation1 

 
(2)  Power Reset Operation from the Menu 

Select [R/C Power Reset] from the [File] menu to reset the power to the robot controller.  
 

 
 

Fig. 7-45 Power reset operation from the menu 
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7.11.  Password 

"Password" is used by the Mitsubishi service personnel to change the robot's system information. 
Unconditionally select "No password" here. 

 

 

 
Fig. 7-46 Password 
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7.12. Print of Parameter 

 
The parameter values in the robot controller can be printed. 
With the print function, the parameter values can be output to the printer or saved in a file. 
This function is supported in C1 or later version of this software. 

 

7.12.1. Print out  
The [Print] button is displayed on the HAND Parameter screen or the Parameters screen that is displayed 

via the parameter setting menu. 
    

 
Fig. 7-47 Print button 

  
If the [Print] button is clicked, the Print screen is displayed.  

 
Fig. 7-48 Print out 

Confirm the printer to print, and then click the [OK] button. The parameter information that is currently being 
displayed is output to the designated printer.  

 
 

7.12.2.  Print to file 
If a printer is not connected to the PC, the loaded information can be output to a file. Check [Print to file] on 

the Print screen above, and then click the [OK] button. At this time, the file is saved in the text format so that it 
can be read by a general text editor (MemoPad, WordPad, etc.)  

 



7. Parameter editing tool 

Starting  7-135 

7.13. Exit the Parameter editing tool 

 
 

 
Fig. 7-49 Exiting the Paramter editing tool 

 
Click on the [Exit] button on the screen or click on the "End" button on the tool bar.  
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8. Backup/Restore 
The information on the robot controller can be backed up to the personal computer, or the backup 

information saved on the personal computer can be restored to the robot controller.  
 

Backup  
(Robot → Personal computer) 

Saves the backup data on the robot controller to the personal 
computer. 

Restore  
(Personal computer → Robot) 

Transfers the backup data saved on the personal computer to the 
robot controller. 

 
 

8.1. Starting 

Select [Backup/Restore] from the menu. The following 
"Backup/Restore" window appears. 

 
Fig. 8-1 Backup/Restore 

 

Precautions when executing a backup/restore operation during  
the replacement of  a controller (CPU)  
    that supports Maintenance Forecast 

When executing a backup/restore operation during the replacement of a controller (CPU) that 
supports Maintenance Forecast, also perform the backup/restore operation using the Maintenance 
Forecast tool. 

After a backup operation is performed on a controller that supports Maintenance Forecast, the 
following message is displayed: 

 

 
*  Maintenance Forecast is supported in the controller's software version J1 or later, and version 

E1 or later of this software. 

Caution 
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8.2. Backup ( Robot -> PC ) 

Save the information on the robot controller to a file on the personal computer.  
Click the [Backup] button. The following window appears. Select the robot controller you are backing up.  

 

 
Fig. 8-2 Backup 

 
   The controller selected in [Robot Controller] 

for the communication server is displayed 
as the initial value (Version D3 or later). 
(The No. 1 robot controller is displayed in 
Versions D1 and D2.) 

 
Fig. 8-3 The controller selected for the communication server 

 
 

<< Backup >> 
 All Files : Saves all files (robot program, parameter files, etc.) in the robot controller into the 

designated folder.  
 Program : Saves the robot program file into the designated folder. 
 Parameter Files : Saves the parameter files into the designated folder. 
System Program : Saves the system base program file into the designated folder. 

 
Note that this Save (Robot → Personal computer) is intended to back up the robot controller, so the 

program cannot be edited using the program editing tool. 
 

[Parameter List Files]  This is used to edit the parameter information saved by backup in offline mode, 
and is not required for backup. If this is not checked, the time required to save all files 
will be shortened. 

 
BKUP.SYS and MECHA.SYS files are automatically created in the designated folder. These files contain 

the saved mechanical information of the robot controller and describe the save format. If these files are 
deleted or overwritten, please note that offline data editing and data transfer to the robot controller cannot be 
performed. 
 

Precaution for Backup 
When backing up the values of the robot (system) status variables and the values of the program 

external variables, reset the power to the robot controller first, and then perform a backup operation. 
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8.3. Restore ( PC -> Robot) 

The backup data saved in the personal computer is transmitted to the robot controller. 
Select the robot controller at the transfer destination. 

 

 
Fig. 8-4 Restore 

 
   The controller selected in [Robot Controller] 

for the communication server is displayed 
as the initial value (Version D3 or later). 
(The No. 1 robot controller is displayed in 
Versions D1 and D2.) 

 
Fig. 8-5 The controller selected for the communication server 

 
 

<< Restore >> 
 All Files : Transfers all files (except BKUP.SYS and MECHA.SYS) in the designated folder to the 

robot controller after all information in the robot controller is cleared (initialized).  
 Program : Transfers the robot program file in the designated folder to the robot controller. 
Parameter Files : Transfers the parameter file in the designated folder to the robot controller. 
System Program : Transfers the system base program file in the designated folder to the robot controller. 

 
[Change Robot Origin Data] Valid only when [All Files] or [Parameter Files] is selected under [Backup]. 

 
 If checked : Replaces the origin information in the robot controller with the contents of the mechanical 

parameter file to be transferred.  
 If not checked : Loads the origin information from the robot controller, transfers the information in the 

designated folder, and then returns the origin information that has been loaded to the 
robot controller. 
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Backup 

 files 
 
 

controller 

Check ON 

 

Check OFF 

 

Ver. J2 
or later 

 

Restore 
files 

controller 

 

 Origin data(A) 

 parameters for 
position repair (A)

 Parameters(A) 

<リストア前> 

 

 Origin data(B) 

 parameters for 
position repair (B)

 Parameters(B) 

controller 

 

 Origin data(B)

 parameters for 
position repair (B)

 Parameters(B)

<after restore><before restore> 

An initial value will be used if the file to
be restored does not have any
revision parameter for position repair.

Transfers a backed up file as is. The origin data 
is replaced. 

 
 

Restore 
files 

<after restore> 
controller 

 

 Origin data(A)

 

 Parameters(A)

<リストア前> 

 

 Origin data(B) 

 parameters for 
position repair (B)

 Parameters(B) 

controller 

 

 Origin data(A) 

 parameters for 
position repair (A)

 Parameters(B) 

<before restore>

parameters for 
position repair (A)

 
 
 
A backed up file is transferred. However, as for 
the origin data and the parameters for 
recovering positions, the information inside the 
controller is retained. 

Ver. H7 or 
earlier 

<after restore>

controller 

 

 Origin data (A) 

 Parameters(A) 

controller 

 

 Origin data (B)

 

 Parameters(B)

<before restore> 

Revision parameters for position
repair will not be written 

Restore 
files 

<リストア前> 

 

 Origin data(B) 

 parameters for 
position repair (B)

 Parameters(B) 

Transfers a backed up file as is. The origin data 
is replaced. 

Restore
files 

<after restore> 

controller 

 

 Origin data(A)

 Parameters(A)

<リストア前> 

 

 Origin data(B) 

 parameters for 
position repair (B)

 Parameters(B) 

controller 

 

 Origin data(B) 

 

 Parameters(B) 

<before restore>

Revision parameters for position 
repair will not be written. 

A backed up file is transferred. However, as for 
the origin data, the information inside the 
controller is retained. 

(*”Position Repair” is supported in version E1 or later of this software.) 
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If communication is cancelled during a series of load processing, please note that the origin data may have 

been changed. 
 

 

Precaution for Restore 
When a program is running or the ALWAYS program is set up 

Ver. E1 
or later 

If a batch restoration or a program restoration is 
executed when the program is being started, the 
program will automatically be stopped.  
At this time, if there is an error in the controller, 
the program in operation cannot be stopped, 
and the message shown on the right will be 
displayed.  
Although a restoration process can be executed even in such a case, the program 
currently selected or the program that is started by ALWAYS cannot be re-written. If it is 
possible to remove the cause of the error, reset the error and execute the restoration 
process again. 
 

Ver. D2 
or earlier 

Be sure to stop the program. 

Caution 
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8.4. Power Reset of the Robot Controller (Version E1 or later) 

To make the restored information effective, it is necessary to power on the robot controller again. The power 
reset of the robot controller can be performed from the personal computer in Version E1 or later of this 
software. 

However, note that this function can be used with Version J1 or later of the robot controller software. 
 
 
(1) Restore 

After restoring, the power reset conformation screen appears. To immediately reset the power, select [Yes]. 

 
Fig. 8-6 Confirmation of Power reset  

 
 

(2) menu 
Selecting [R/C Power Reset] from the [File] menu can reset the power to the robot controller. 

 
 

  

 
Fig. 8-7 Operation by menu 
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8.5. Program Backup 

 
Several robot programs are copied between the R/C and personal computer. 
The robot programs copied to the personal computer can be edited with this software. 

 

 
Fig. 8-8 Program backup/Restore menu 

 
Select [File] - [Program Backup].  
The Program Backup window will open.  

 

 
Fig. 8-9 Program backup 

 
Using the [Add] button, set the file to be copied into the copy source area.  
The file selected as the copy source can be canceled by selecting with the [Clear] button.  
After selecting the copy destination, click on the [Copy] button.  
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9. Remote maintenance 
 

The data of a robot at a remote location can be monitored and serviced over a telephone line. 
 
Prepare a personal computer with modem and telephone line at the robot side and at the remote location. 

Connect each personal computer with the following method. 
 

9.1. Starting of Remote maintenance 

Click on the "Remote maintenance" button on the main screen. The remote maintenance tool will start, and 
the following type of dialog will appear. 

 
Fig. 9-1 Confirmation 

 
If the program editing tool, monitoring tool or maintenance tool is running, exit the tool, and then click on the 

"OK" button. The following main screen will appear. 
 

Line connection button 

Connection state with remote
robot is displayed. 

A message is sent to the connection
destination. 

Messages from connection
destination will appear. 

Switches ON/OFF of the 
beep sound when receiving a 
message. 

 
Fig. 9-2 Remote Maintenance 
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9.2. Connecting with the remote robot 

Click on the "Line connection" button. 
The following line setting screen will appear. Input the telephone No., and type of modem being used, and 

then click on the "Start" button. The remote connection different type of letters. 

 

Select "Server" for robot side, 
and "Client" for remote location 
side. Input the connection

destination name. 

Input the telephone No. 

Select the modem 
being used. 

 
Fig. 9-3 Line setting 

 

If the personal computer being used is connected to an intranet, connection with LAN instead of 
a telephone line is possible. 

Caution 

 
 
The following screen will appear when the "Dial property" button is clicked on. The details regarding the 

telephone being used can be set. Take special care to the dialing method (tone (push line) or pulse (dial line)). 
 

Caution!! 
Dialing method 

 
Fig. 9-4 Dialing properties 
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10. Simulation 
(Only for standard installation) 

 
The simulation methods are explained in this section. 
 

 

The simulation function is compatible only with the "standard version". 
Note that the simulation function also cannot be used when the MOVEMASTER commands are 
selected with the "standard version". 

Caution 

 
 
 

The Robot might occur error of a speed limit over so on though operation speed quickens when 
the "simulation condition" is set to [High-speed]. 
In that case, the error might not occur if the "simulation condition" is set to [High-accuracy] again. 

Caution 

 
 

The robot program's operation can be simulated using the program editing tool. The simulation function can 
be used with the [Simulation] menu. 

 

 Simulation View : Simulation screen display. 
 Execute, Stop : Simulation execute/stop switch.
Simple cycle calculation : Calculates cycle. 
 Error Monitor : Error display. 

 
Fig. 10-1 Simulation menu 

 

 

10.1. Simulating operation 

 

10.1.1. Start of Simulating operation 
The program being edited (only when always open) can be simulated. The types of simulation are the same 

as the robot controller, and include [Automatic operation], [Step execution] and [Direct execution]. 
 
To simulate the operation, select one of the following from the [Simulation] menu [Execute/stop]. 

 
Fig. 10-2 [Simulation] [Execution/stop] submenu 

 
[Automatic operation] 
[Step execution] 
[Direct execution] 
 

The following "Model selection" dialog will appear, so select the model and then click on the "OK" button. 
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Model selection 

Hand and  
workpiece setting 

(Version F1 or earlier) (Version F2 or later) 

1) Type selection 

2) Model selection 

 
Fig. 10-3 Model selection dialog 

 
The following "Simulation results" view panel will appear, and the state of the simulation of the program 

currently being edited will appear. 
 
 The angle for viewing the robot can be changed. *1 

The virtual controller's mode during simulation
operation can be changed. 
To change the virtual controller parameter information, 
set to "TEACH". "AUTO" is used for the simulation 
operation. 

When a robot with travel is selected, edit the display 
information for the travel base. 

JOG operation is carried out with the simulation robot. 
In this case, set the above Mode Changeover to 
"AUTO".

 
Fig. 10-4 Simulation panel 

 
*1  The viewpoint can also be changed by the following mouse operations. 

Viewpoint of changing Mouse operations on the graphic 
Rotation Dragging left button to left and right Æ Rotation of Z-axis center 

up and down Æ Rotation of X-axis center 
Dragging left + right button to left and right Æ Rotation of Y-axis center 

Move Dragging right button to up, down, left and right Æ Move 
Enlargement/reduction Dragging left button + [Shift] key to up and down Æ Enlargement/reduction 
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Communication with the robot controller is not possible while the simulation panel is opened. To 
communicate with the robot controller, close the simulation panel ([Simulation] menu -> Simulation 
view). 

Caution 

 
 
 
[Travel Base Display Information] 

When a robot with travel is selected, edit 
the display information for the travel base. 
The display information is changed here. 
 
 
 
 
 
 
 
 
 
 
To change the robot's movement range, 
select "Yes (Y)". The parameter values will 
change. Note that program editing must be 
restarted to validate these parameters. 

 
 
 

Fig. 10-5 Travel base information  
 
 

10.1.2. Automatic operation 
The same operation as the controller's automatic operation takes place. 
To stop, select [Stop] from the [Simulation] menu → [Execute/stop]. 

 
 
 
 

10.1.3. Direct execution 
The robot can be directly operated by inputting command statements without line Nos. 
When [Simulation] menu → [Execute/stop] → Direct execution 
 is selected, the following type of dialog for direct execution will appear. 

 

Describe direct 
execution command 

Transmission 

Direct command 
transmission history

 
Fig. 10-6 Direct execution dialog 
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10.1.4. Step execution 
The robot program can be executed line by line. 
When [Simulation] menu → [Execute/stop] → Step execution is selected, the following type of dialog for 

step execution will appear. During the step execution, the line being executed is highlighted on the program 
editing screen. 

 
 

 
 

Executing line highlighted display. Step operation.

 
Fig. 10-7 Step execution dialog and highlighted editing screen 
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10.2. Cycle time calculation 

 
*** Quit all other applications before calculating the tact time. *** 

 
 

Attention when cycle time of robot 
 which uses the collision detection function or the maintenance forecast. 

When the collision detection function is made effective, or the information gathering level of the 
Maintenance forecast is raised, the cycle time of the robot is postponed.  But, in this software, even 
if they are changed, cycle time is not influenced 

When the collision detection function is made effective, or the information gathering level of the 
Maintenance forecast is raised, please note that the cycle time of the robot is postponed from the 
tact time measurement result of this software by about 3-10% 

Caution 

 
 

The tact time can be calculated with two methods using this software. 
(1) Calculate the tact time from the created robot program. 
(2) Designate the robot movement's start point and end points, and calculate the movement tact time. 

Each calculation method is described below. 
 
 

10.2.1. Cycle time calculation conditions 
 

 Tact time(Cycle time) calculation 
The robot's movement tact time can be calculated with this software using the simulation function. 
Note that the calculated tact time will differ according to the performance of the personal computer 

used and the load state, and will not completely match the actual robot movement time (tact time). 
Use this function as a guide for considering the tact time. 
 
The results of the tact time calculated with this software will have an error of approx. +/-3% under 

the following conditions compared to the actual robot movement time (tact time). 
 

Tact time calculation conditions 
(1) Do not start any application other than this software's "Program Edit" function. 

The tact time calculation by this software has sections processed in the background of the 
personal computer. For example, if an application such as a Word document that carries out 
automatic save is started and running, this software's background process will take longer and 
the correct tact time may not be calculated. (The tact time will increase.) 
Quit all other applications before calculating the tact time with this software. 

(2) There must be no general-purpose signal input waiting in the program. 
Invalidate any signal input waiting, etc., before calculating the tact time. 
When considering the tact time of this type of program, add the approximate input waiting time 
to the calculation results. 
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 Precautions for using this software   
 

When calculating the tact time using this software's simulation function, the tact time may not be
correctly calculated depending on the specifications of the personal computer being used or the
robot's drawing posture. 

Use under the following conditions to calculate the tact time. 
Quit all applications other than this software when calculating the tact time. 

 
1. Recommended personal computer specifications 

CPU over 233MHz  
Memory over 128MByte  

 
 
2. When using recommended specification personal computer 

The following type of "Simulation Results" will appear when the tact time is calculated. 
Set this window's focus as X axis = 0, Y axis = 0, Z axis =0, Zoom = 1 as shown below. 

 
 

This function does not need to be changed when using Windows NT. 
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3. When using non-recommended specification personal computer 

Iconize the "Simulation Results" window. The operation methods are shown below. 
The drawing posture does not need to be changed when the window is iconized and the

tact time is calculated. 
[Operation methods] 
(1) Open the robot program for which the tact time is to be calculated. 
(2) Open "Simulation View" under the menu "Simulation", and select the robot model. 

At this time, always set the conditions to "High Accuracy". 
(3) The "Simulation Results" window will open. Iconize this window. 

The icon can be created by clicking the button on the upper right of the window. 

 
(4) Select the execution section for which the tact time is to be calculated, and calculate the tact

time by selecting "Simulation" - "Simple Tact Calculation" - "Tact Calculation". Refer to section 
"5.5.2 Calculating the Tact Time" for details on calculating the tact time. 

(5) Do not return the "Simulation Results" window to 
the original size while calculating the tact time. 
When the tact time has been calculated, the 
"Tact Calculation Results" window as shown on 
the right will open. 

Note: In some cases, this "Tact Calculation Results" 
window may be hidden behind a different window. In 
this case, press the [Alt] key on the keyboard, or 
click on the "Tact Calculation Results" icon 
displayed on the task bar. 
This completes the calculation of the tact time.  
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10.2.2. Calculating the tact time from the robot program 
The tact time of a designated range of the robot program can be calculated. Note that the following limits will 

apply. 
 

Note: Observe the following points when calculating the tact time from the robot program. 

 

 

 

 

 

 

 

For example, the tact time cannot be calculated for the following types of programs. 

(The sections of the program highlighted in black are set so that the tact time can be calculated.) 

 

1. The tact time for a program that falls into an infinite loop cannot be correctly calculated. 

Confirm that the robot program does not fall into an infinite loop with a FOR statement or GOTO statement. 

2. The tact time cannot be calculated for a program having signal input waiting, etc. Invalidate any signal input 

waiting, etc., before calculating the tact time. 

3. With the PC support software prior to version C1, a program containing an END statement cannot calculate 

the tact time. 

10 … 
：  ： 
100 MOV P01 
110 MOV P02 
120 MOV P03 
130 GOTO 10 
140 END 

When the GOTO statement's
jump destination is not
selected 

10 GOTO 120 
20 ' 
30 *SUB1 
40 MOV P01 
50 RETURN  
60 ' 
120 *START 
130 MOV P02 
140 MOV P03 
150 GOSUB *SUB1 
160 END 

10 MOV P00 
：  ： 
100 GOSUB *SUB1
110 END 
120  ： 
200 *SUB1 
210 MOV P01 
220 RETURN  

When the subroutine's jump
destination is not selected
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[Operation methods] 
1) Open the robot program. 
2) Select the execution section for which the tact time is to be calculated.  
  The section can be selected by dragging with the mouse. 

 

2) Select the program. 

3) Select menu. 

 
Fig. 10-8 Select the program 

 
3) Select the menu "Simulation" - "Simple Cycle Calculation" - "Cycle Calculation". 
4) The Cycle Calculation Range Confirmation window will appear. After confirming the range, click on 
[Execute]. 

Confirm that the selected program is correct. 

4)

 
Fig. 10-9 Confirm the selected program 
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5) If the Simulation Viewer is not opened, the robot model selection window will appear. Select the robot model, 
and then click on [OK]. 

6) When the Simulation Condition Setting window appears, click on [High-accuracy]. 
      

5)

6) 

 
Fig. 10-10 Model selection and Simulation condition setting 

 
7) The robot movement will appear on the Simulation Viewer, and the tact calculation process will start. 
8) When the tact calculation is completed, a window showing the tact calculation results will appear. 

      

7) 
8)

 
Fig. 10-11 Simulation and cycle calculation result 
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10.2.3. Calculation by designating the robot movement transit point. 
Even without describing a robot program, the robot operation cycle time can be calculated by designating 

the robot movement transit point.  
 

1). To calculate the cycle, select [Simulation] menu → [Simple cycle calculation]. The following general 
operation setting dialog will appear 

 

1)

 
Fig. 10-12 Movement transit point 

 
 

 

Designate the operation start 
position. 

Target position list

Adds, changes, inserts or deletes the 
target position. 

Calculates the tact

2)

3) 

4) 

 
Fig. 10-13 General operation dialog 

 
2) Calculate the tact with the following procedure. 

   Select the robot operation start point from the [Start position]. The position variables registered in the 
position variable template (displayed with [Tool] menu → [Position variable template]) can be selected. 
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3) When the [Add] button is clicked on, the target position addition dialog shown below will appear. Set the 
target point with this dialog. The position variables registered in the position variable template (displayed 
with [Tool] menu → [Position variable template]) can be selected. 

Select operation 
interpolation type 

Designate speed override 

Set workpiece grasping 
Wait time after operation 

Movement target position 

3) 

 
Fig. 10-14 Transit point setting dialog 

 
4) Select the added transit point from the list, and then click on the [Movement confirmation] button to comfirm 

the movement. And click on the [Cycle calculate] button to know the cycle time. 
5) The simulation view will open, the robot operation state will appear, and the cycle time will appear when the 

operation is completed. 

 
Fig. 10-15 Cycle calculation results 
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10.3. Editing the position variables with the simulation robot 

The position variables can be edited by moving the simulation robot, and reading in the position variables 
from the simulation robot's posture. Use the following procedure. 

Start up the simulation screen by selecting [Simulation view] from the [Simulation] menu. 
 

The angle for viewing the robot can be changed. 
The viewpoint can also be changed by the following 
mouse operations: 
* Dragging left button 

left and right Æ Rotation of Z-axis center 
up and down Æ Rotation of X-axis center 

* Dragging left + right button 
left and right Æ Rotation of Y-axis center 

* Dragging right button 
up, down, left and right Æ Move 

* Dragging left button + [Shift] key 
up and down Æ Enlargement/reduction 

 
Fig. 10-16 Simulation panel 

 
When the [JOG operation] button is clicked on, the following JOG operation dialog will appear. The 

simulation view robot can be operated with this dialog. Operate the simulation robot and set the robot to the 
required posture. 

 

Click on the axis 
button for the 
direction to move to. 

With JOG operation, only the 
joint coordinates can be 
monitored. 
For the orthogonal coordinates, 
click on the "Retrieve Current 
Position" button after the robot 
movement stops. 

Set the inching. 
 
If you set ‘High’ or ‘Low’, the 
robot moves a fixed amount 
every time the key is 
pressed. 
The amount of movement 
depends on the individual 
robot. 

 
Fig. 10-17 JOG operation dialog 
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Select the position variable to be edited from the program position variable editing screen being edited, and 
then click on the [Change] button. To newly add a position variable, click on the [Add] button. 

 

Select position variable to be changed

 
Fig. 10-18 Position editing screen 

 
The current position of the simulation robot will be read in when the [Current position read] button on the position 
variable change and add dialog is clicked on. 

 

Reads in robot's current position. 

 
Fig. 10-19 Position variable change dialog 
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11. Program conversion 
 

The "Robot programming supporter" for E/EN/M1 and M2 series (hereafter "old PC support S/W") and this 
software (hereafter "new S/W") differ in the configuration of position data. Therefore, the program prepared by 
using the old PC support S/W cannot be used as it is in the new S/W. 

The program conversion converts the position data as well as the instructions (DJ, MP, and PD instructions of 
the Move Master command) related to the position data so that the robot programs created and saved by the old 
PC support S/W can be used with this new S/W. 

 
 

11.1. Precautions 

 
 
Note 1: The program conversion converts the position data as well as the instructions (DJ, MP, and PD 

instructions of the Move Master command) related to the position data. It is not possible to convert 
automatically from MELFA-BASIC III data to MELFA-BASIC IV data. Be sure to make grammatical check 
using the new S/W before using the program saved by the old PC support S/W. 

 
Note 2: The program for M1/M2 prepared by using the old PC support S/W has the base rotated 90º. When 

using the program for M1/M2, convert M1/M2 program into EN program using the old PC support S/W 
before carrying out the program conversion. 

 
Note 3: In the case of the old PC support S/W, the data can be saved separately such as command sentence 

only, position data only or command sentence and position data. In this program conversion, it is 
possible to convert the file of command sentence only and the file of position data only to one program. 
The other combinations can not be made. 

 

Position data only

Command sentence only

Program

ＯＫ

ＮＧ

Case 1:

Case 2:

Case 3:

Case 4:

Program
conversionPosition data

Command sentence
+ Program

ＯＫ

Program
conversion

Program
conversion

Program
conversion ＮＧ

Case 5:

Program
conversion ＮＧ

Case 6:
Program

conversion ＮＧ

Case 7:
Program

conversion ＮＧ

Position data

Command sentence
+

Case 3:

Position data

Command sentence
+

Case 4:Case 3:

Position data

Command sentence
+

Case 5:Case 4:Case 3:

Position data

Command sentence
+

Command sentence only

Command sentence only

Command sentence only

Position data only

Position data only

Position data only

Case 3:

Case 4:

Case 5:

 

Make sure to read through the items of caution given below before carrying out program conversion.
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11.2. Start-up 

There are two methods to start up. 
 

(1) Start up from MENU 
Click on the [Program Converter] button using the MENU of the MELFA Personal Computer support 

software. 
 

(1)

(2)

 
Fig. 11-1 main menu 

 
 
 

(2) Start up from PROGRAM EDIT 
Click on the [Program converter] in the [Tool] menu of the ‘Program Edit Tool - [Robot.prg: BASIC edit 

mode]’ window. 

 
Fig. 11-2 [Tool] menu of the Program edit tool 
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11.3. Operation methods 

 
(1)  Select the number of axes of the robot. Make sure to select the correct number of axes, since the position data 

structure of the old PC support S/W differs according to the number of robot axes. 

 
Fig. 11-3 Program Converter 

 
(2) Designate the source files.   

The [OPEN] window for file selection appears when the [Select] button of the [Source Files:] is clicked. 
 

 
Fig. 11-4 Designate the source files 

 
 

Click the file while pressing the [Ctrl] key for selecting several files. After selecting the file for conversion, 
click on the [Open] button. Then the selected files appear in the [Source Files:] box. 
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(3) Designate the file to write down the converted program.  Click on the [Select (D)] button of the [Destination 
File:] to display the [Save As] window for file selection. 

 

 
Fig. 11-5 Designate the file to write down the converted program 

 
Name the file in which the converted program is written before clicking on the [Save] button. 

 
 
(4) After designating the conversion source file and the conversion destination file, click on the [Convert] or 

[Convert & Open] button.   
When [Convert] is clicked, the designated file is converted and written down in the conversion destination file.  
When [Convert & Open] is clicked, the file is converted before being opened through program edit.  Select 
according to the object. 
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12. Position Repair Support Tool 
 
“Position Repair Support Tool” is supported by version E1 or later of this software. However, supported Robot 

Controller and Model are limited. See “Table 12-2 Supported Robot Controller and Model”. 
“Position Repair Support Tool” is used when tool deformation due to interference or origin position shift due to 

replacement of motor during maintenance occurs. Past position data in the controller can be used simply by 
re-teaching certain location data in a robot program. (Parameters that compensate for the position shift will be 
generated, which corrects all location data within the controller.)  
 
However, please note that applications that require high precision or large mechanical damage to the robot 

due to interference may not be rectifiable. 
Moreover, there are some cases that cannot be rectified because of limits by degree of freedom of robot. 

Vertical 5-axis robot and Horizontal 4-axis robot have the limit like “Table 12-1 The limit by degree of freedom“. 
Therefore the shift related to this limitation cannot be correctly rectified. In that case, please teach again 
without using this function, or repair the part where the gap exists. (e.g. exchanged a bent hand) 
 

Table 12-1 The limit by degree of freedom 
No. Robot model The limit by degree of freedom 

1 Vertical 5-axis robot It can’t move in the direction of C element of the cartesian 
position. 

2 Horizontal 4-axis robot It can’t move in the direction of A, B element of the 
cartesian position. 

 
 
 

Position Repair Support Tool supports MELFA-BASIC IV only. 

Position Repair Support Tool supports MELFA-BASIC IV only. Note that it cannot be used with 
MOVEMASTER command. 

CAUTION 

 
 
 
 

12.1. Specifications 

 
This software supports the following software version and model of the robot controller. 
 

Table 12-2 Supported Robot Controller and Model 
No. Robot model Support Version Robot Controller 

1 Vertical 6-axis robot Version E1 or later 
Version J2 or later 
Only correction of origin data is supported in 
versions prior to J2. 

2 Vertical 5-axis robot Version F1 or later 
Version K1 or later 
Only correction of origin data is supported in 
versions prior to K1. 

3 Horizontal 4-axis robot 
(RH-SH series only) Version F2 or later 

Version K4 or later 
Any versions prior to K4 are not available. 
Moreover, This function cannot be used for the 
RH-AH series robot. 
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12.2. Startup 

 
Click the [>>] button in the main menu to expand the menu. Select [Position Repair] to display Position Repair 

window.  
It is also possible to start from Windows [Start] – [Programs] – [MELSOFT Application] – [RT ToolBox] – 

[Position Repair]. 
(It is possible to start from Windows [Start] – [Programs] – [MELFA] – [CR-500 Position Repair].) 
 

 
[1] Click [>>] button to expand the menu. 

The button changes to [<<] after the menu expands. 

[2] Click [Position Repair] button. 

 
Figure 12-1 Starting from Menu 
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12.3. Operation Flow 

This software is an application in Wizard format. Parameters will be generated if you perform operations 
following the instructions on each screen. The parameter values can also be set directly. 
 
This software is used while connected to the robot controller. 
 
 

Specify the target robot 

Specify the program to use for
parameter generation (within robot
controller) 

Move robot to re-teaching position 
(Use the teaching box) 

Specify the parameters to be generated

Enter parameter values 

Parameter generation 

Write parameters to robot controller

Execute re-teaching calculation 

Write parameters to robot controller

Automatic parameter 
generation 

 (Normal operation)
If setting 

parameters 

Re-teaching Work
 Procedure 

Backup the parameters before revision

Back up the selected program 

Restart robot controller power 

Restart robot controller power 

Repeat as 
necessary

 
Figure 12-2 Operation Flow 

 
From here on, the description will follow the normal operation flow. See “12.16. Edit Revision Parameters” 

for description on setting parameter values. 
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12.4. Starting Use 

 
Figure 12-3 Starting use Window 

 
This window shows the description of this software. Click [Next] after reading the description. 
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12.5. Communication Setting 

 
Figure 12-4 Communication setting Window 

 
Check the communication server setting. While connected to the robot controller, click [Next]. Please see 

“2.3.3. Communication Setting ” on how to perform the setting. 
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12.6. Select the Robot and Backup Parameters 

 
Figure 12-5 Select the robot and backup parameters Window 

 
Select the robot to execute the re-teaching.  
Robot is displayed as follows. 

 

Controller number : Controller Name + Mechanism Name #Mechanism No.

Displayed only in  
multi-mechanism mode 

 
 
If you wish to perform parameter backup, select [Back up] and specify the Save folder. Stored parameter file 

can be retrieved into the robot controller using the “Backup/Restore” in the "RT ToolBox  Robot Total 
Engineering Support Software".  
Click [Next] when ready to proceed. 
 
 

Parameter Backup 

During its operation, this software overwrites parameters to the robot controller.  
It is recommended that the parameters be backed up at this point to allow the controller to revert

to the original parameters. 

Memo 
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12.7. Select Generation Procedure of Revision Parameter 

 
Figure 12-6 Select generation procedure of revision parameter Window 

 
In the next step, the software can either automatically generate parameters or accept manually entered 

parameter values. Normally, [Generate revision parameter automatically] is selected. 
 
Select [Generate revision parameter automatically] and click [Next] to proceed to “Select Program” window.  
Select [Edit the value of revision parameter directly] to proceed to “Edit Revision Parameter” window. 
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12.8. Select Program 

 
Figure 12-7 Select Program Window 

 
Select the robot program to be used for revision parameter generation and click [Next].  
Re-teaching will be performed using the position data of orthogonal coordinate system of the selected 

program.  
See “Table 12-3 Selecting Revision Parameters” on the number of required position data. 
 
 

The points on selecting the program 

Select the program with the positions of various location and posture. 
Moreover, Higher accuracy of revision parameters can be obtained by selecting the following

type of position data program. 
* Program with positions that are easy to re-teach 
* Program with positions that require high precision 

Memo 

 
 



12. Position Repair Support Tool 
 

Read and Backup Program 12-173 

12.9. Read and Backup Program 

 
Figure 12-8 Read and backup program Window 

 
To back up a program, select [Back up] and specify the Save folder. Stored program file can be retrieved into 

the robot controller using the “Program Manager” in this software.  
Click [Next] when ready to proceed. 
 

 

Robot Program Backup 

During its operation, this software may overwrite robot controller program (position data).  
It is recommended that the program be backed up at this point to allow the controller to revert to

the original program. 

Memo 
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12.10. Check of Setting Tool 

 
Figure 12-9 Check of setting tool Window 

 
Parameter values set in the present robot controller for tool data are displayed. The row for the tool selected 

by the tool number (MEXTLNO) is highlighted in red.  
Please check if the tool data and tool number used during teaching is set.  
If necessary, change the value from parameter setting in teaching box. Click [Renew List] to update the 

contents of the display.  
(If the robot controller’s version is older than J2, only the standard tool (MEXTL) will be displayed.)  
 
Click [Next] when ready to proceed. 
 
 

Do not change tool data or base data. 

After this window, do not change tool data or base data.  
If they are changed during re-teaching operation, re-teach calculation cannot be done correctly. 
When correcting tool data, if teaching was performed switching back and forth between multiple

tools, perform re-teaching operation for each tool. 

CAUTION 
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12.11. Select Revision Parameter 

 
Figure 12-10 Select Revision Parameter Window 

 
Select the revision parameter that becomes the target for re-teaching calculation.  
 
Revision parameter will be selected automatically if an item is selected from [Select revision parameter].  
Choose [Select all] to select all the revision parameters. If you wish to specify a particular combination of 

revision parameters, choose [Select arbitrarily] and specify the revision parameters.  
 

Vertical 6-axis robot If the robot controller’s version is older than J2, only [Error of joint 
axis] can be selected. 

Vertical 5-axis robot If the robot controller’s version is older than K1, only [Error of 
joint axis] can be selected. 

Horizontal 4-axis 
robot 

(RH-SH series only) 

Any versions prior to K4 are not available. 
(This function cannot be used for the RH-AH series robot.) 

 
Click [Details] to see the description of the difference between checking and not checking [Use the posture 

elements of position data]. 
 

In the following section, details regarding revision parameters and posture elements of position data are 
explained.  

 
 
After choosing the revision parameters, click [Next]. 
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12.11.1. About Revision Parameters 
The following table describes the parameters to be revised based on the item selected in “Select Revision 
Parameter” window. 
 

 
 
 

Some elements cannot be calculated according to  
the robot type and the combination of  revision parameters. 

In this function, the amount of the gap of the robot is calculated as a correction value, and the
revision parameter is generated. However, some elements cannot be calculated (the value 
becomes 0) as the following two kinds of cases. 

 
* The case which cannot be calculated by the limits of degree of freedom of robot 

Some elements of revision parameter cannot be reflected because the Vertical 5-axis robot 
and horizontal 4-axis robot have the limitation. 
 

* The case which condensed by the combination of robot mechanism 
 and revision parameter 

Some elements of revision parameter become the value on the same rotation axis according
to the combination of robot mechanism and revision parameter. In such case, calculated
value of gap is condensed to the one element of revision parameter. 
At this case, though the other element becomes 0, it condenses in other elements and 
 it is corrected. So it is not necessary to reflect it again. 

Memo 
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Table 12-3 Selecting Revision Parameters 

Minimum number of teach 
points 

No. Item Description Revised 
Parameter Vertical 

6-axis 
robot 

Vertical 
5-axis 
robot 

Horizontal 
4-axis 
robot 

1 
Error of joint 

axis 
 

Rectifies origin data when joint axis moves or 
when motor is replaced. 
Specify the target axes using the check boxes. 
The number of teaching points is different 
according to how the axis was specified. 

Origin data
1 to 6 
points 

1 to 5 
points

1 to 4 
points 

2 
Tool exchange 

or modified 

Rectifies attachment error when robot tool is 
exchanged. In addition, rectifies tool data error 
when the tool is transformed due to 
interference between robot and peripheral 
devices. 
Vertical 5-axis robot: 
* Only Z element of position data is 

corrected. 
  

Tool data 
3 to 6 
points 1 point 3 to 4 

points 

3 
Transfer the 

robot 
 

Rectifies base data of robot position setup 
when the robot is transferred to another 
location.  
Vertical 5-axis robot: 
* Only X, Y, Z elements of position data are 

corrected. 
  

Base Data
6 

points 
3 

points 4 points 

4 
Exchange the 

robot 
 

When robot is exchanged with the tools on, 
rectifies origin data error and base data of robot 
position setup.  
Only for horizontal 4-axis robot, attachment 
error is also rectified. 
Vertical 6-axis robot: 
* Origin data J1 is included in base data. 
Vertical 5-axis robot: 
* As to base data, only X, Y, Z elements are 

corrected. 
Horizontal 4-axis robot: 
* Origin data J1 and J3 are included in base 

data. 
* Origin data J3 and J4 are included in tool 

data. 
* Select which to be requested because Z 

elements of tool data and base data are 
not corrected at the same time. 

  
  

Base data 
Origin data

 

Tool data 
(4-axis robot 

only) 
 

(5-axis and 
6-axis robot)

 

(4-axis 
robot) 

10 to 
11 

points 

7 to 8 
points

7 to 8 
points 



12. Position Repair Support Tool 

12-178 Select Revision Parameter 

Minimum number of teach 
points 

No. Item Description Revised 
Parameter Vertical 

6-axis 
robot 

Vertical 
5-axis 
robot 

Horizontal 
4-axis 
robot 

5 
Select all 

 

Selects all revision parameters.  
Vertical 6-axis robot: 
* Origin data J1 is included in base data. 
* Origin data J6 is included in tool data. 
Vertical 5-axis robot: 
* As to tool data, only Z element is 

corrected. 
* As to base data, only X, Y, Z elements are 

corrected. 
Horizontal 4-axis robot: 
* Origin data J1 and J3 are included in base 

data. 
* Origin data J3 and J4 are included in tool 

data. 
* Select which to be requested because Z 

elements of tool data and base data are 
not corrected at the same time. 

  
  

Origin data
Tool data 
Base data 13 to 

16 
points 

8 to 9 
points 

7 to 8 
points 

6 
Select 

Arbitrarily 
 

Specify revision parameters.  
Vertical 6-axis robot: 
* Since origin data J1 is included in base 

data, if base data is selected, turn off the 
Checkbox of origin data J1. 

* Since origin data J6 is included in tool 
data, if tool data is selected, turn off the 
Checkbox of origin data J6. 

Vertical 5-axis robot: 
* As to tool data, only Z element is 
corrected. 
* As to base data, only X, Y, Z elements are 

corrected. 
Horizontal 4-axis robot: 
* If base data is selected, turn off the 

Checkboxes of origin data J1 and J3. 
Origin data J1 and J3 are included in base 
data. 

* If tool data is selected, turn off the 
Checkboxes of origin data J3 and J4. 
Origin data J3 and J4 are included in tool 
data. 

* If tool data and base data are selected 
together, select which Z element to be 
requested, because Z elements of tool 
data and base data are not corrected at 
the same time. 

  
  

    

* Revision parameter names correspond to the following. 
Origin data: DJNT 
Tool data: MEXDTL, MEXDTL1 to 4 (Parameter of the tool selected by tool number) 
Base data: MEXDBS 
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12.11.2.  About Posture Elements of Position Data 
Position data of MELFA-BASIC IV consists of tip position (X, Y, Z) and tip posture elements (A, B, C) (*1). 

This section describes the cases where [Use the posture elements of position data] is checked and not 
checked. 
 
 

(*1) The posture elements of  position data 

In case of the vertical 6-axis robot, the posture elements of position data are (A, B, C). 
In case of the vertical 5-axis robot, the posture elements of position data are (A, B). 
In case of the horizontal 4-axis robot, the posture element of position data is (C). 

Memo 

 
 
 

(1) [Use the posture elements of position data] is checked  
Not just the robot tip position (X, Y, Z) but also the tip posture elements are used for position correction 

calculation.  
Precision of generated revision parameter improves if the tip posture elements are also re-taught correctly.  
However, if the tip posture elements are not re-taught correctly, as shown in the diagrams below 

(re-teaching positions P1 and P2), error occurs in position correction calculation, decreasing the precision 
of the calculation result. 

If posture elements are
re-taught accurately

Re-teaching
position P1

Re-teaching
position P2

Original position and posture

Position and posture before
re-teaching

Position and posture after
re-teaching

Re-teaching position

Original position
and posture

Re-teaching
position P3

If posture elements are not re-taught accurately

 
 

(2) [Use the posture elements of position data] is not checked  
Posture elements in the position data taught during re-teaching are not used for position correction 

calculation.  
If it is not necessary to match exactly the tip posture elements during re-teaching, clear the checkbox [Use 

the posture elements of position data]. In such case, position correction calculation is performed using only 
the tool tip position data (X, Y, Z), ignoring the error from posture deviation. This increases the precision of 
location correction.  
However, there are certain restrictions. Please refer to the following “Table 12-4 About Posture 

Elements of Re-teaching Position Data” for details. 
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Table 12-4 About Posture Elements of Re-teaching Position Data 

Condition Merit Note 
When using posture 
 elements of position 
data 

Precision of generated revision 
 parameter improves if the tip 
position (X, Y, Z) and tip posture 
elements are re-taught correctly. 

During re-teaching, posture must be 
taught correctly. If posture data is 
incorrect, precision of revision 
parameter actually decreases. 
 
In case of the vertical 6-axis robot :  
* Posture elements (A, B, C) of tool 

revision parameters cannot be obtained.
* J6 axis of origin revision parameter 

cannot be obtained if both X and Y 
components of the tool parameter are 
0.0. 

In case of the vertical 5-axis robot :  
* J6 axis of origin revision parameter 

cannot be obtained. 

When not using 
 posture elements of 
position data 

During re-teaching, revision 
 parameters can be generated 
simply by correctly teaching position 
(X, Y, Z).  
(Posture elements need not be 
accurate.) 

In case of the horizontal 4-axis robot : 
* Posture elements (C) of tool revision 

parameters cannot be obtained. 
* J4 axis of origin revision parameter 

cannot be obtained if both X and Y 
components of the tool parameter are 
0.0. 
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12.12. Re-teach Work 

 
Figure 12-11 Re-teach work Window 

 
[Remainder] Displays the number of remaining points until revision parameters are generated.  

However, at some positions, re-teaching may not decrease the number of remaining points.  
[Re-teach] button Specifies the positions selected in the list and opens “Re-teach the position” screen. 
[Clear] button Clears the re-teaching information for positions selected in the list. 
[Check of tool data] button Displays current tool data setting in the robot controller. 

 

Position data of  the targeted program is write-protected. 

During showing this window, the position data of the targeted program in the controller is 
write-protected. If this tool is interrupted when not communicating with the controller, the position 
data cannot be unprotected. Please release the protect by using the Teaching Box or Program
manager of this software. 

CAUTION 

 
 
Position data for the program selected are displayed.  
Select the position to re-teach from the list and repeat re-teaching to generate revision parameters. 
 
Re-teaching work procedure can be described as follows. While the “Re-teach the position” screen is open, 

move the robot to the re-teaching position and click the [Load current position] button on the screen. 
 

 
Figure 12-12 Re-teach the Position Screen 
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Revision parameter generation 

Re-teaching 

Click [Re-teach] button Æ Re-teach the position Screen opens

Move the robot to re-teaching position 
(Use the teaching box to move) 

Click [Load current position] button

Select the position to re-teach from the list 

(Re-teaching calculation) Æ Position Re-teaching window closes

Re-teach the position Screen

Repeat 

 
Figure 12-13 Re-teaching Work Procedure 

 
 
Row for re-taught position will be highlighted in light blue.  
Re-teaching does not change the position data values shown in the list. 
 
 

Do not perform position correction using the teaching box. 

When you move the robot to the re-teaching position using the teaching box, be careful not to
correct the position.  

During re-teaching, position data of the applicable program in the controller is write-protected. 

CAUTION 

 
 
 

Do not change tool data, tool number, or base data. 

Do not change tool data, tool number, or base data during re-teaching. Re-teaching calculation 
will not be performed correctly.  

When correcting tool data, if teaching was performed switching back and forth between multiple 
tools, perform re-teaching operation for each tool. 

CAUTION 

 
 
 

Select position data with a different posture element,  
when re-teaching two or more positions. 

Select position data with a different posture element,  when re-teaching two or more positions.
When position data of the same posture element are selected, there is a possibility that the

parameter is not correctly calculated. 

CAUTION 
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The cautions when using a robot with the additional axis . 

Please re-teach at the position in which the additional axis is same as the original position 
when re-teaching by a robot with the additional axis. Otherwise, re-teaching calculation will not 
be performed correctly. 

CAUTION 

 
 
It is possible to change the revision parameters to be generated.  
Go back one step to the “Select revision parameter” window to change the setting. Note that if you return 

one more step to “Check of setting tool” window, all information set by re-teaching work will be cleared. 
 
 

When go back to “Check of  setting tool” window, all 
information set by re-teaching work will be cleared. 

CAUTION 
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12.13. Write Parameters 

 

 
Figure 12-14 Write Parameters Window 

 
[Print] Prints the revision parameter information displayed in the list. 
[Save position data to file] Saves position data used in re-teaching as a robot program with positions 

only. Position data will be values converted by the revision parameters. 
 
 
Revision parameters and their values generated by re-teaching are displayed.  
Click [Next] button to write the parameters into the robot controller. 
 

 

If  revision parameters could not be generated 

If revision parameters could not be generated, parameters are not displayed in the list.  
If you click the [Next] button, position data used in re-teaching is written into the robot controller. 

Since parameters are not generated, position data will not be converted. 
 
Parameters may not be generated under the following conditions. 
* When one of the specified re-teaching positions is of a significantly low precision 
* When one of the original position data is of a significantly low precision 
* When the difference between the original position data and the re-teaching position is too large
* When tool data or base data was changed during re-teaching 
 
Clicking the [Back] button and redoing a part of the re-teaching may generate revision parameters. 

Please delete the re-teaching information for the position data that meets one of the criteria
mentioned above and perform re-teaching again. 

CAUTION 
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12.14. Re-start the Power Supply of the Controller 

 
Figure 12-15 Re-start the power supply of the controller Window 

 
To activate the written parameters, turn off and then turn on the power of robot controller.  
Click the [Power supply reset] button to reset the robot controller from the personal computer.  
(If the robot controller’s version is older than J2, robot controller cannot be reset from the personal computer. 

In this case, operate the controller power manually.) 
 

 

Controller Power Reset 

Check the surroundings for safety before resetting the robot controller power from the personal
computer. 

CAUTION 
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12.15. Finish 

 
Figure 12-16 Finish Window (After Re-teaching) 

 
When the writing of revision parameters is done, operation of this software is complete. 
 

Perform an operation check before exit this software. 

Before exit this software, make sure that all position data works properly. 
If revision is not correct, click the [Return to re-teach] button to continue re-teaching. (However, if 

you exited from “Edit revision parameters” window, [Return to re-teach] button will not be shown.) 

CAUTION 

 
 
 

Back up the parameters. 

This software has changed the revision parameters.  Back up the parameters before exit this
software. 

CAUTION 

 
 

 

Position data close to operation area boundaries  
may not be rectifiable. 

Around the operation area boundaries, position error may put a point outside the operation area, in
which case this software cannot rectify the point. 

CAUTION 
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12.16. Edit Revision Parameters 

 
This window is displayed if [Edit the value of revision parameter directly] is selected in “12.7 Select 

Generation Procedure of Revision Parameter”. 
 

 
 
 
 
 

 
Figure 12-17 Edit Revision Parameters Window 

 
[Print] Prints the revision parameter information displayed in the list. 
[Reset] Resets all changes. 

 
 

Displays values of current revision parameters in the robot controller.  
Select parameter from the list and double-click it to display the setting screen. Set the parameter values.  
(If the robot controller’s version is older than J2, only the origin revision parameter (DJNT) is shown.)  
 
Click [Next] to write all parameters into the robot controller and proceed to “Re-start the Power Supply of 

the Controller” window. 
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13. Maintenance Forecast 
 
In Maintenance Forecast, the parts replacement (grease replenishment, battery and belt replacements) times 

can be checked from the up-do-date operating data collected inside the controller. 

The results of  calculations in Maintenance Forecast merely show 
reference values. 

Please execute the daily inspection and the periodic inspection to 
prevent the breakdown beforehand, and to secure safety. 

 
Caution 

 
 

13.1. Specification 

 
The following lists the software versions and models of the robot controllers supported by this software: 

 
Table 13-1 Supported models and software versions 

No. Robot This software Robot controller 

1 RV-12S series 
RV-6S series Ver. J2 or later 

2 RV-3S series 
RV-3SJ series Ver. K1 or later 

3 
RH-6SH series 
RH-12SH series 
RH-18SH series 

Ver. E1 or later 

Ver. K4 or later 

 
 

13.2. Start 

After verifying the connection with the robot controller, click the [>>] button on the main menu to expand the 
menu, and then select [Maintenance Forecast]. The Maintenance Forecast window appears. 

 
 (1) Click the [>>] button to expand the window. 

This button changes to [<<] while expanding. 

(2) Click [Maintenance forecast] button. 
 

Fig. 13-1 Maintenance Forecast 
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13.3. Select the target controller and robot 

Select the target controller and robot in the Maintenance Forecast window. The controller being connected to 
[Robot] in the windows are displayed together with its model name.  Verify the controller and its model, and then 
click the [Next>] button in the lower area of the window. 

 

 
Fig. 13-2 Maintenance Forecast 

 
When the [Reload] button is clicked, the information about the controller being connected and its model is 

updated. 
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13.4. Forecast (Battery) 

When the information for Maintenance Forecast has been loaded from the controller, the Forecast window 
(initially, the [Battery] information) appears. 

 

 
Fig. 13-3 Forecast(Battery) 

 
If the number of remaining hours of battery life has reached  
(Remainder time) < [The remainder days until presumed maintenance time] on the Setup screen) 

 x (24 - [Operation time of a day]) 
, the hours and bar graphs are displayed in orange. 

(The battery replacement time is calculated during the time when the controller’s power is not on.) 
 
When the [Refresh] button is clicked on in upper-right corner of the window, the information about the 

maintenance is acquired again from the controller. 
 
 
Here, the battery and belt replacement times as well as the grease replenishment time can be checked. To 

switch between displays, select the applicable item in the Item combo box. 
 

 
Fig. 13-4 Changing an Item 
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13.5. Forecast (Grease) 

When [Grease] is selected in Item, the "hours until grease replenishment time" can be checked for 
each axis. 

 
Fig. 13-5 Forecast(Grease) 

 

The “Operation time of a day” can be set on the Setup screen.  
 
If the hours until replenishment time has reached  

(Hours until replenishment time) 
 < ([The remainder days until presumed maintenance time] on the Setup screen)  

x ([Operation time of a day]),  
the hours and bar graphs are displayed in orange. 

 
The display unit setting can be switched between time and day.  

If day is selected in the display unit setting, the display will show the number of days in operation based on the 
operating hours per day. 

 
When the [Refresh] button is clicked on in upper-right corner of the window, the information about the 

maintenance is acquired again from the controller. 
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13.6. Forecast (Belt) 

When [Belt] is selected in Item, the "hours until belt replacement time" can be checked for each axis. 

 
Fig. 13-6 Forecast (Belt) 

 

The “Operation time of a day” can be set on the Setup screen.  
 
If the hours until belt replacement time has reached  

(Hours until belt replacement time) 
 < ([The remainder days until presumed maintenance time] on the Setup screen)  

x ([Operation time of a day]),  
the hours and bar graphs are displayed in orange. 

 
The display unit setting can be switched between time and day.  

If day is selected in the display unit setting, the display will show the number of days in operation based on the 
operating hours per day. 

 
When the [Refresh] button is clicked on in upper-right corner of the window, the information about the 

maintenance is acquired again from the controller. 
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13.7. Setup 

Click the Setup tab. 
Here, the timing to collect the information for Maintenance Forecast, the notification method and other items 

can be set up. 
 

 
Fig. 13-7 Setup 

 
When the [Write Parameters] button is clicked after setting each item, the setting values are written into the 

controller. All items other than the signal numbers of dedicated outputs take effect after they are written into the 
controller. If a dedicated output signal has been changed, it is necessary to power on the controller again. 

 
For more information about the setup items, see “Tab. 13-2 Description of the Setup Screen” 
 
 

Information needed to “Maintenance Forecast” is not accumulated  
while the Maintenance forecast is being invalidly set. 

Factory preset value is invalidity. When the 
Maintenance Forecast is invalidated, information 
of Maintenance Forecast is not accumulated. 
When switched effectively from invalidity again, 
the reservoir of information is continued from the 
last value. If you have invalidated the 
Maintenance Forecast for a long term, the 
correct maintenance times cannot be 
calculated. 

Caution 

invalidity
Information is accumulated.

Maintenance Forecast
     Effective

Reservoir of information

time
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Table 13-2 Description of the Setup Screen 

Item Explanation 
Factory 
preset 
value 

(1) Maintenance Forecast is 
made effective. 

If this is checked, the Maintenance Forecast function takes effect. 
* If a checkmark is removed, the collection of the information for 
Maintenance Forecast stops, and the correct maintenance times cannot 
be calculated. 

Check 
ON 

(2) Collection level of 
 information 

Five levels can be specified to collect the information about the 
maintenance. 
* As an information collection level gets higher, the accuracy of 
the maintenance improves, but it affects the tact time more. 

1 
(Recomm

ended) 

(3) The interval of the 
 forecast 

Specify the interval to notify the maintenance time. 6 hours 

How to inform When the grease replenishment, belt replacement and other 
maintenance times have reached, they can be notified by generating a 
warning or outputting a dedicated signal. As for the battery replacement 
time, one of warnings, C7500, C7510 and C7520, is generated, 
regardless of whether or not [Warning] under [How to inform] is checked. 
A warning to be generated varies depending on each situation. 

 

(4) Warning If this item is checked, the maintenance time is notified as a warning. The 
warning numbers are listed as follows:  
Grease : C753* (* is the axis No.) 
Belt : C754* (* is the axis No.) 

Check 
ON 

(5) Output Signal If this item is checked, signal numbers can be entered. If this item is 
checked and a signal number is entered correctly, the maintenance time 
is notified using the output of the designated signal. 

Check 
OFF 

(6) Assumption operation 
time of a day  

Enter an estimated robot operation hours per day. 16 hours

 

(7) The remainder days 
until presumed  
maintenance time 

Specify the number of days remaining until presumed maintenance time 
to be used as a reference to notify the maintenance time. 

14 days

 
 

Methods for resetting the alarm and alarm signal output 

As a method of notifying the replacement time of each part, an alarm (C753* and C754* (* represents 
the axis number)), or a dedicated output signal (M*PTEXC (* represents the robot number)) will be 
output.  

If both are set up as the notification methods, executing the error reset operation will reset the alarm 
and end the signal output.  

If the “alarm” method is disabled and only the output of the dedicated output signal is selected as the 
notification method, pushing the reset button on the front side of the controller will not end the signal 
output. In this case, push the [ERROR RESET] key on the teaching box or enter the error reset signal 
(ERRRESET) to end the signal output.  

 
Notification method setting Methods to reset the notification (alarm or dedicated signal output) 

Warning 
Output 

Signal 

Notification method [RESET] key on the 
front of the controller

[ERROR RESET] 
key on the T/B 

External error reset 
signal 

  Alarm Will reset the alarm Will reset the alarm Will reset the alarm

  
Alarm and 

dedicated signal 
output 

Will reset the alarm 
and the dedicated 

signal output 

Will reset the alarm 
and the dedicated 

signal output 

Will reset the alarm 
and the dedicated 

signal output 

  
Dedicated signal 

output 

Will not reset the 
dedicated signal 

output 

Will ENABLE reset 
the dedicated signal 

output 

Will ENABLE reset 
the dedicated signal 

output 

Memo 
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13.8. Reset 

The information (about battery, grease and belt) for Maintenance Forecast kept in the controller can be reset. 

 
Fig. 13-8 Reset 

 
Table 13-3 Description about each reset 

Types of resets Explanation Note 
At the time of battery 
exchange 

It is used when an alarm urging to replace 
the batteries (C7500, C7510 or C7520) 
occurs and the batteries have been replaced.

Be sure to reset the battery consumption time 
after a battery has been replaced. 

  

At the time of grease 
replenishment 

When an alarm urging to perform periodic 
inspections and replenish grease (alarm 
numbers in the 7530s) occurs, replenish the 
grease and reset the replenished axis. 

Axes are reset in units of joint 
axes. Multiple joint axes can 
be reset at the same time. 

At the time of belt 
exchange 

When an alarm urging to perform periodic 
inspections and to replace the belt when it is 
damaged (alarm numbers in the 7540s) occurs, 
replace the belt and reset the axis for which the 
belt is replaced. 

Axes are reset in units of joint 
axes. Multiple joint axes can 
be reset at the same time. 

 
These reset operations can be executed using the teaching box. See the following section for further details.  
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When the [Log] button is clicked in the upper-right corner of the window, the previous reset date/time and reset 
count can be checked. 

However, the battery reset count is not displayed. 
If no reset has not made previously, “----/--/--  --:--:--“ is displayed. 
 

 
Fig. 13-9 Log of Reset 
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13.9. Reset the Maintenance Forecast information using the 
teaching box 

When an alarm urges to replace the batteries, replenish the grease, or to replace the belt based on the 
Maintenance Forecast function and these parts are replaced or replenished, the information that has been 
accumulated within the controller needs to be reset for the axis where such replacement or replenishment has 
been performed.  

The information that has been accumulated within the controller can be reset using not only this software, but 
also the teaching box. 

 

13.9.1. Resetting the time of battery consumption 
 

Table 13-4 Resetting the time of battery consumption 
 Explanation Operation 

the time of 
battery 
consumption 

It is used when an alarm urging to replace the 
batteries (C7500, C7510 or C7520) occurs 
and the batteries have been replaced. 
Be sure to reset the battery consumption time 
after a battery has been replaced. 

On the menu screen of the teaching 
box, press the “5. MAINT” -> “2. INIT” 
-> “2. Battery” keys.  
 

 
See “Controller INSTURCTION MANUAL – Detailed explanations of functions and operations” for how to 

initialize the time of battery consumption using the teaching box. 
 
 

13.9.2. Resetting the grease and belt information 
 
The grease and belt information can be reset by entering parameters to the controller.  
The following is the list of parameter names and the values to be entered. 

 
Table 13-5 Resetting the grease and belt information 

 Explanation Parameter Value 

Grease 
information 

When an alarm urging to perform 
periodic inspections and replenish 
grease (alarm numbers in the 7530s) 
occurs, replenish the grease and 
reset the replenished axis. 

MFGRST 

Belt 
information 

When an alarm urging to perform 
periodic inspections and to replace 
the belt when it is damaged (alarm 
numbers in the 7540s) occurs, 
replace the belt and reset the axis for 
which the belt is replaced. 

MFBRST 

0     : Reset information on 
 all axes 
 
1 to 8 : Reset information on 
 the specified axis 

 

(* These parameters cannot be read not to input all characters in the teaching box.) 
 
The grease or belt information will be reset immediately after a parameter name and the value are entered. (In 

this case, the controller power does not need to be restarted.) If a value other than 0 is entered, the reset 
process will be executed for each axis.  

Repeat the parameter input operation when resetting information on two or more axes. 
Also note that the value read is always 0 regardless of the previously entered value. If you continue the input 

operation in this state, all axes will be reset. Exercise caution. 
 

See “Controller INSTURCTION MANUAL – Detailed explanations of functions and operations” for how to input 
parameters using the teaching box.  
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13.10. Others 

The information for Maintenance Forecast kept in the controller can be backed up and/or restored. 
 

 The backup and restore operations are performed  
when the controller (CPU) is replaced. 

When the controller (CPU) is replaced, perform both backup and restore operations in a batch 
using the Backup/Restore tool. Also, be sure to back up the information for Maintenance Forecast 
before replacement, and restore the backed up information after replacement. 

After the controller (CPU) has been replaced, if the information for Maintenance Forecast is not 
restored, or it is restored after a substantial time has elapsed since the time of backup, please 
note that the reliability of Maintenance Forecast will be degraded. 

Caution 

 
 

 
Fig. 13-10 Others 
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13.11. Exiting the Maintenance Forecast tool 

Click the [Back] button displayed in the lower area of the window. The display returns to the initial target robot 
selection window. Click the [Exit] button in this window. 

 
  

 
Fig. 13-11 Exiting the Maintenance Forecast tool 
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14. Setup of the communication middleware 
“MelfaRXM.ocx” 

 
14.1. Overview 

MelfaRXM.ocx is an ActiveX control that communicates with the robot controller.  
MelfaRXM.ocx is enclosed by the "RT ToolBox Robot Total Engineering Support Software" standard 

version. However, when using only the function of the "Robot Total Engineering Support Software", it is not 
necessary to install  MelfaRXM.ocx. 

 
By using MelfaRXM.ocx, the Windows application linked to MELFA ROBOT can be created easily on your 

equipment. 
 

 
 

14.2. Description in CD-ROM 

The CD-ROM(standard) contains the following items: 
Refer to the instruction manual in CD-ROM for the usage of MelfaRXM.ocx. 
 

Utility 

Setup.exe 

MELFARXM 

Setup.exe 

¥:

Doc

ReadMe.txt 

: 
: 
: 

:
:

The files for installation of 
"RT ToolBox  Robot Total Engineering Support Software".

Communication 
middleware 

MelfaRXM.ocx 
related file 

The files for installation of MelfaRXM.ocx 

Instruction Manual( pdf) 

text file which indicated notes 

 
Fig. 14-1 Description in CD-ROM 

 
 
 

An instruction manual and notes of MelfaRXM.ocx are enclosed in CD-ROM of the standard
version "RT ToolBox Robot Total Engineering Support Software". 
When MelfaRXM.ocx and "RT ToolBox Robot Total Engineering Support Software" live together in
one personal computer, we ask you to surely read the instruction manual --"3.2 When making
it coexist with the 'Robot Total Engineering Support Software '"-- of the communication middleware
“MelfaRXM.ocx”. 
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14.3. Guide for reading the manual 

The manual is in the CR-ROM as the Adobe PDF file. 
D:/Utility/MELFARXM/Doc/MelfaRXME.pdf 

* Example for the CD-ROM drive is “D:”. 
 
(1) Prepare for reading 

(i) Prepare of the personal computer 
The personal computer with which is installed Microsoft® Windows® 98 or more and it has the  CD-ROM 
drive is required. 

(ii) Prepare of the software for reading 
For reading the manual, Adobe Acrobat Reader Ver.5.0 or more is required. 
If Adobe Acrobat Reader isn’t installed, please download from following Adobe Systems Incorporated  
URL(As of December, 2004). 

URL:  http://www.adobe.com 
 
(2) How to read 

(i) Case of starting from Explorer 
Start Explorer and select the file. Then Acrobat Reader starts and the manual is displayed.  

(ii) Case of starting directly from Acrobat Reader 
Start Acrobat Reader and select the file. Then the manual is displayed.  

 
 
 

 
 
Microsoft, Windows, Microsoft Windows NT are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries. 
 
Acrobat Reader Copyright 1987-1999 Adobe Systems Incorporated. All rights reserved. 
Adobe, the Adobe logo, Acrobat, and the Acrobat logo are trademarks of Adobe Systems Incorporated. 
 
Reference to registered trademarks and trademarks are omitted in this manual. 
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14.4. Installation 

Perform installation according to the following procedure: 
 

(1) Insert the program CD-ROM into the CD-ROM drive 
of your personal computer. Setup of “RT ToolBox
Robot Total Engineering Support Software” 
automatically starts.  Please click “cancel” . 

(2) Select [Run] from the [Start] button. 
 

  

(1) Click the [Start] button.

(2) Select [Run] 

Fig. 14-2 Selecting [Run] 
 

(3) Check the drive name of the CD-ROM drive. Enter the following and click the [OK] button. : 
       "drive name":/Utility/MelfaRXM/Setup.exe 
       (If the CD-ROM drive is “D”, enter “D":/Utility/MelfaRXM/Setup.exe”) 

 
Fig. 14-3 [Run] Screen 

 
(4) Installer starts and the Setup screen appears. Install according to the instructions that appear on the 

screen.  
The Product ID is needed when this "MelfaRXM.ocx" is installed.  Input the Product ID same as the 
Product ID of "RT ToolBox".  "MelfaRXM.ocx" can be installed with the Product ID of standard version, 
but can not be installed with mini version's. 

 
Fig. 14-4 Input Product ID 

 
The files listed in Table 14-1 are installed at the destinations as indicated. 
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Table 14-1 : Files to be Installed 

No. Description Install destination 
1 MelfaRXM.ocx 

2 EZSocketRC.dll 
(communication DLL) 

3 NarcServerApiM.dll 
(communication DLL) 

/Windows/System folder 
ex) Windows® 98/ Windows® Me : /Windows/System 
 Windows NT®/ Windows® 2000 : /Winnt/System32 
 Windows® XP : /Windows/System32 

MelfaRXM.ocx and EzSocketRC.dll are registered in the registry. 

4 RoboCom.exe 
(communication DLL) 

5 Instruction Manual 

6 Sample programs 

7 Redistribution files 

 

MelfaRXM_Dev 

A folder specified during install operation (Normally, C:/ is used.) 

ReadMe.txt··········text file which indicated notes 
[RoboCom]··········folder of communication server 
[Doc] ···················folder of Instruction Manual 
[Sample]··············folder of sample programs 
 
 
 
[Redist] 

[BCB]···········Borland C++ Builder (5.0) 
[VB] ·············Visual Basic (6.0) 
[VC++] ·········Visual C++ (6.0) 

[Installer] ······ folder of system files Installer (for redistribution)
[SysFiles] ····· folder of system files (for redistribution) 
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Appendix (Function tree) 
 BASIC edit 

Line No. hide 

Current position read 

MDI input 

(Line) Copy and paste 

Search, Find in files and 

Replace 

Jump 

Renumber 

Automatic renumber 

Grammar check 

Command template 

Position variable template 

Position variable batch edit 

Cut 

Program editing tool Edit Command edit 

Position variable edit 

Editing auxiliary functions 

Debug editing 

Program Program list 

Program copy 

Program move 

Program protect 

Program compare 

Program rename 

Program delete 

Simulation 

Step execution 

Direct execution 

Automatic operation 

Cycle calculation 

Step execution 

Direct execution 

Position read 

The simulation function is compatible only with the
"Standard version". The function cannot be used with the
"Personal computer support software mini". 
Note that the simulation function also cannot be used
when the MOVEMASTER commands are selected with
this software . 
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Backup/Restore Batch backup 

Batch restore 

Monitoring tool Robot movement monitor 

Operation monitor 

Servo monitor 

Slot operation status monitor 

Stop signal monitor 

Error monitor 

Program monitor 

General-purpose input signal monitor 

General-purpose output signal monitor 

Movement confirmation monitor 

Operating time cumulative monitor 

Production information monitor 

Robot version 

Position monitor 

Speed monitor 

Current monitor 

Load monitor 

Power monitor 

Remote maintenance Connection with remote robot

General-purpose output signal monitor 

Movement confirmation monitor 

Input register 

Output registers 

Option card information 

Program conversion 

Parameter editing tool Parameter change 

Position Repair support 

Maintenance Forecast 

 

 



 

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

OCT.2006 Printed in Japan on recycled paper.                                               Specifications are subject to change without notice. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

HEAD OFFICE:  TOKYO BUILDING, 2-7-3, MARUNOUCHI, CHIYODA-KU, TOKYO 100-8310, JAPAN
NAGOYA WORKS:  5-1-14, YADA-MINAMI, HIGASHI-KU, NAGOYA 461-8670, JAPAN  


	Mitsubishi Industrial Robot
	RT ToolBox
	Contents


	1. Before starting use 
	1.1. Using the instruction manual
	1.1.  
	1.2. Confirming the product
	1.1.  
	1.3. Items to be prepared by user

	2. Preparation before use 
	2.1. Installation methods
	2.1.1. Installation
	2.1.2.  Uninstallation

	2.2. Setting up the printer
	2.3.  Connecting to the robot
	2.3.1. Using RS-232-C
	2.3.2.  Using Ethernet
	2.3.3.  Setting the communication server


	1.  
	1.  
	1.  
	3. Basic functions and window operations
	3.1. Basic functions
	3.2.  Basic Windows operations

	4. Starting use 
	4.1. Starting
	4.2.  Creating a program
	4.3.  Teaching a position
	1.1.  
	4.4.  Confirming the operation with simulation
	1.1.  
	4.5.  Saving the program
	4.6.  Exiting the editing screen
	1.1.  
	4.7.  Confirming the movement
	1.1.  
	4.8. Exit the operations

	1.  
	5. Program editing tool
	1.1.  
	5.1. Setting the screen
	5.1.1. Font
	5.1.2.  Variable display area setting
	5.1.3. Syntax check setting
	5.1.4.  Program Language
	5.1.5. History

	1.1.  
	5.2. Editing screen
	1.1.  
	5.3. Editing mode
	5.3.1. BASIC editing mode
	5.3.2. Line No. hide mode
	5.3.3.  Changing the editing modes

	1.1.  
	5.4. Opening a program
	5.4.1. Opening programs on a PC
	5.4.2.  Opening a program on a robot controller
	5.4.3.  Read items when opening the program on the robot controller

	1.1.  
	5.5. Closing and saving a program
	5.5.1. Save
	5.5.2.  Save on Personal Computer
	5.5.3. Save on Robot
	5.5.4.  Write Items When Saving on the Robot Controller
	5.5.5.  Precaution for saving program in controller

	1.1.  
	5.6. Editing the program
	5.6.1. Program language
	5.6.2. Registering a program command statement
	5.6.3.  Deleting a program line
	5.6.4. Describing a comment statement
	5.6.5. Inputting a position variable (Only for BASIC editing mode)

	1.1.  
	5.7. Editing the position data
	5.7.1.  Editing the position variable
	5.7.2.  Editing a position variable array
	 


	1.1.  
	5.8. Editing auxiliary functions
	5.8.1. Copy
	5.8.2.  Line copy (Only BASIC editing mode)
	5.8.3. Cut
	5.8.4.  Line cut  (Only BASIC editing mode)
	5.8.5. Paste
	5.8.6.  Search
	5.8.7.  Find In Files
	5.8.8.  Replace
	5.8.9.  Jump
	5.8.10.  Partial Transmission
	5.8.11.  Automatic numbering (Only BASIC editing mode)
	5.8.12.  Assigning line Nos.
	5.8.13.  Command template
	5.8.14. Position variable template
	5.8.15.  Position variable batch change
	5.8.16.  Program conversion

	1.1.  
	5.9. Syntax check
	1.1.  
	5.10. Debugging a program
	5.10.1. Open the program
	5.10.2.  Step execution
	5.10.3.  Direct execution

	1.1.  
	5.11. Program Management 
	5.11.1.  List
	5.11.2.  Copy
	5.11.3. Movement
	5.11.4.  Delete
	5.11.5. Rename
	5.11.6.  Protect
	5.11.7.  Comparison


	6. Monitoring tools
	6.1. Starting
	6.2. Outline of each function and starting methods
	6.3. Exit the monitor menu
	1.1.  
	6.4. Each monitor function
	6.4.1. Robot movement monitor
	6.4.1.1. Slot Run State
	6.4.1.2. Stop Signals
	6.4.1.3.  Error
	6.4.1.4.  Program monitor
	6.4.1.5.  General-purpose input signals
	6.4.1.6.  General-purpose output signal
	6.4.1.7.  Named signal
	6.4.1.8.  Movement State
	6.4.1.9.  Input register
	6.4.1.10.  Output register

	6.4.2.  Operation monitor
	6.4.2.1. Operating time accumulation
	6.4.2.2. Production information
	6.4.2.3.  Robot version
	6.4.2.4. Additional Board Information

	6.4.3.  Servo monitor
	6.4.3.1. Position ( ABS )
	6.4.3.2. Speed
	6.4.3.3.  Current
	6.4.3.4. Load
	6.4.3.5.  Power



	7. Parameter editing tool
	7.1. Starting of Parameter editing tool
	7.2.  Selecting the Read Destination
	7.2.1. Selecting a robot controller

	1.1.  
	7.2.2. Selecting files

	7.3.  Downloading the parameter list (Controller -> PC)
	1.1.  
	7.4. Changing the parameters
	 
	7.6. Parameter menu
	7.6.1.  Motion Limit Parameter
	7.6.2. JOG Parameter
	7.6.3.  Hand Parameter
	7.6.4. Workpiece and Hand Weight
	7.6.5.  Tool
	7.6.6.  Slot Table
	7.6.7.  OUTPUT Signals Reset pattern
	7.6.8.  Special-purpose I/O Signals assignment
	7.6.9.  Communication Parameter
	7.6.10. Zone
	7.6.11.  Free Plane Limit
	7.6.12. Home position
	7.6.13.  Program Language

	1.1.  
	7.7. Search
	7.8.  Initialization
	7.8.1. Initializing the battery remaining time

	1.1.  
	7.9. System information
	7.9.1. Robot origin data
	1.1.1.  
	7.9.2. Robot Origin Parameter <Backup>

	1.1.  
	7.10. Power Reset of the Robot Controller (Version E1 or later)
	1.1.  
	7.11.  Password
	1.1.  
	7.12. Print of Parameter
	7.12.1. Print out 
	7.12.2.  Print to file

	7.13. Exit the Parameter editing tool

	 
	8. Backup/Restore
	8.1. Starting
	1.1.  
	8.2.  Backup ( Robot -> PC )
	1.1.  
	8.3. Restore ( PC -> Robot)
	8.4.  Power Reset of the Robot Controller (Version E1 or later)
	1.1.  
	8.5. Program Backup
	1.1.  
	1.1.  

	9. Remote maintenance
	9.1. Starting of Remote maintenance
	9.2.  Connecting with the remote robot

	10. Simulation (Only for standard installation)
	10.1. Simulating operation
	10.1.1. Start of Simulating operation
	10.1.2. Automatic operation
	10.1.3. Direct execution
	1.1.1.  
	10.1.4. Step execution

	1.1.  
	10.2.  Cycle time calculation
	10.2.1. Cycle time calculation conditions
	10.2.2.  Calculating the tact time from the robot program
	10.2.3.  Calculation by designating the robot movement transit point.

	1.1.  
	10.3. Editing the position variables with the simulation robot

	11. Program conversion
	11.1. Precautions
	11.2.  Start-up
	1.1.  
	11.3. Operation methods

	12. Position Repair Support Tool
	12.1. Specifications
	1.1.  
	12.2. Startup
	1.1.  
	12.3. Operation Flow
	1.1.  
	12.4. Starting Use
	1.1.  
	12.5. Communication Setting
	1.1.  
	12.6. Select the Robot and Backup Parameters
	1.1.  
	12.7. Select Generation Procedure of Revision Parameter
	1.1.  
	12.8. Select Program
	1.1.  
	12.9. Read and Backup Program
	1.1.  
	12.10. Check of Setting Tool
	1.1.  
	12.11. Select Revision Parameter
	1.1.1.  
	12.11.1. About Revision Parameters
	1.1.1.  
	12.11.2.  About Posture Elements of Position Data

	12.12. Re-teach Work
	1.1.  
	12.13. Write Parameters
	1.1.  
	12.14. Re-start the Power Supply of the Controller
	1.1.  
	12.15. Finish
	1.1.  
	12.16. Edit Revision Parameters

	13. Maintenance Forecast
	13.1. Specification
	13.2. Start
	13.3. Select the target controller and robot
	1.1.  
	13.4. Forecast (Battery)
	1.1.  
	13.5. Forecast (Grease)
	1.1.  
	13.6. Forecast (Belt)
	1.1.  
	13.7. Setup
	1.1.  
	13.8. Reset
	1.1.  
	13.9. Reset the Maintenance Forecast information using the teaching box
	13.9.1. Resetting the time of battery consumption
	13.9.2. Resetting the grease and belt information

	13.10.  Others
	13.11. Exiting the Maintenance Forecast tool

	14. Setup of the communication middleware “MelfaRXM.ocx”
	14.1. Overview
	14.2. Description in CD-ROM
	 Guide for reading the manual
	14.4.  Installation
	Appendix (Function tree)



